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Caracteristici de diagnosticare

a computerelor

Diagnostics for Windows

Programul utilitar Diagnostics for Windows (DFW) vd permite

sd vizualizati informatii despre configuratiile hardware si software
ale computerului cand se utilizeazd Microsoft Windows XP. Acesta
vd mai permite si efectuarea de teste hardware si software pentru
subsistemele computerului.

Cand lansati Diagnostics for Windows, se afiseazd ecranul Overview
(Prezentare generald), care prezintd configuratia curentd a computerului.
Din ecranul Overview, existd acces la cateva categorii de informatii
despre computer si fila Test. Informatiile din fiecare ecran al
programului utilitar se pot salva intr-un fisier sau se pot imprima.

Pentru a testa toate subsistemele, trebuie si vd conectati ca
administrator. Dacd nu vd conectati ca administrator, nu veti avea
posibilitatea sa testati unele subsisteme. Imposibilitatea de a testa

un subsistem se va indica printr-un mesaj de eroare afisat sub numele
subsistemului din fereastra Test sau prin casete de selectare umbrite
care nu se pot selecta.

Pentru a determina dacd toate dispozitivele instalate pe computer sunt
recunoscute de sistem si dacd functioneaza corect, utilizati programul
Diagnostics for Windows. Executarea testelor este optionald, dar este
recomandatd dupa instalarea sau conectarea unui dispozitiv nou.

Dispozitivele de la la alti furnizori, care nu sunt acceptate de HP, este
posibil sa nu fie detectate de programul Diagnostics for Windows.
Salvati, imprimati sau afisati informatiile generate de programul
utilitar. Inainte de a apela centrul de asistentd pentru clienti, trebuie
sd executati testele si sd obtineti raportul imprimat.

Ghid de depanare

www.hp.com 1-1



Caracteristici de diagnosticare a computerelor

Detectarea utilitarului Diagnostics for Windows

Unele computere sunt livrate cu Diagnostics for Windows incidrcat
in prealabil, dar nu si instalat. Este posibil sd-1 fi instalat anterior,
impreund cu alte utilitare, sau este posibil sa fi fost instalat de

alt utilizator.

Pentru a determina dacd Diagnostics for Windows este instalat:

1. Accesati locul de amplasare a pictogramelor de diagnosticare.
In Windows XP Home sau in Windows XP Professional,
selectati Start > Control Panel (Start — Panou de control).

2. Examinati pictogramele afisate in Control Panel.

0 Dacd sunt incluse pictogramele Configuration Record
(Inregistrare configuratie) si Diagnostics for Windows, atunci
programul utilitar Diagnostics for Windows este instalat.

0 Daca nu sunt incluse pictogramele Configuration Record
si Diagnostics for Windows, atunci este posibil ca programul
utilitar Diagnostics for Windows si fie Incdrcat dar sda nu
fie instalat.
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Caracteristici de diagnosticare a computerelor

Instalarea utilitarului Diagnostics for Windows

Daci programul Diagnostics for Windows nu este incércat
in prealabil, aveti posibilitatea sd descarcati pachetul SoftPaq
Diagnostics for Windows de la urmétorul sit Web:

www.hp.com/support

Urmdtoarele operatii sunt necesare numai dacd software-ul programului
de diagnosticare a fost incarcat pe unitatea de disc, dar nu a fost instalat.

1. Inchideti toate aplicatiile Windows.
2. Instalati programul utilitar Diagnostics for Windows:

0 In Windows XP, selectati pictograma Start > Setup Software
(Start — Instalare software). Selectati butonul Diagnostics for
Windows > Next, apoi urmati instructiunile de pe ecran.

0 Dacad pictograma Setup Software nu se giseste in spatiul
de lucru si nici Tn meniul Start, executati programul Setup din
directorul C:\CPQAPPS\DIAGS sau selectati Start > Run
(Start — Executare) si in linia de comanda tastati:
C:\CPQAPPS\DIAGS\SETUP.

3. Faceti clic pe Next pentru a instala Diagnostics for Windows.

4. Dupd finalizarea instaldrii programului, este posibil sd vi se solicite
repornirea computerului sau este posibil ca acesta sd reporneascd
automat. Daca vi se solicitd, faceti clic pe Finish (Terminare)
pentru a reporni computerul sau pe Cancel (Revocare) pentru
a iesi din program. Pentru a finaliza instalarea programului utilitar
Diagnostics for Windows, trebuie si reporniti computerul.

% Dacd doriti sa faceti upgrade al unei versiuni existente a programului
Diagnostics for Windows, instalatd pe computer, vizitati
www.hp.com/support pentru a giisi si a descérca pachetul SoftPaq
Diagnostics for Windows.
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Caracteristici de diagnosticare a computerelor

Utilizarea categoriilor din Diagnostics for Windows

Pentru a utiliza categoriile, procedati astfel:

1. Faceti clic pe Start > HP Information Center > Diagnostics
for Windows. Aveti, de asemenea, posibilitatea sa selectati
pictograma Diagnostics for Windows, situatd in Control Panel,
facand clic pe Start > Control Panel si selectaind Diagnostics
for Windows.

Pe ecran se afiseazd prezentarea generala a hardware-ului
si software-ului computerului.

2. Pentru anumite informatii despre hardware si software,
selectati o categorie din meniul vertical Categories (Categorii)
sau selectati pictograma corespunzdtoare din bara de instrumente.

% Cand deplasati cursorul deasupra pictogramelor din bara de instrumente,
langad cursor se afiseazd numele corespunzitor al categoriei.

3. Pentru a afisa informatii mai detaliate dintr-o categorie selectatd,
faceti clic pe More (Mai mult) din caseta Information Level
(Nivel informatii), situatd in coltul din stanga jos al ferestrei,
sau faceti clic pe Level (Nivel) in partea superioard a ecranului
si selectati More.

4. Revizuiti, imprimati si/sau salvati informatiile, dupa cum
este necesar.

% Pentru a imprima informatiile, faceti clic pe File, apoi selectati Print
(Imprimare). Selectati una dintre urmatoarele optiuni: Detailed
Report (All Categories), Summary Report (All Categories),
sau Current Category (Raport detaliat — toate categoriile, Raport
rezumat — toate categoriile sau Categorie curenti). Faceti clic pe OK
pentru a imprima raportul selectat.

% Pentru a salva informatiile, faceti clic pe File, apoi selectati Save As
(Salvare ca). Selectati una dintre urmétoarele optiuni: Detailed
Report (All Categories), Summary Report (All Categories),
sau Current Category (Raport detaliat — toate categoriile, Raport
rezumat — toate categoriile sau Categorie curentd). Faceti clic pe OK
pentru a salva raportul selectat.

5. Pentru a iesi din programul Diagnostics for Windows, faceti clic
pe File, apoi faceti clic pe Exit.
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Caracteristici de diagnosticare a computerelor

Bara de meniu—File, Categories, Navigation, Level, Tab, Help

In partea superioari a ecranului Diagnostics for Windows se afld bara

de meniu care este constituitd din sase meniuri verticale:

B File—Save As, Print, Printer Setup, Exit (Fisier—Salvare ca,
Imprimare, Initializare imprimantd, Iesire)

B Categories (Categorii)—Consultati lista de categorii din
sectiunea urmatoare

B Navigation (Navigare)— Previous Category (Categorie
anterioard) (F5), Next Category (Categorie urmatoare) (F6)

B Level (Nivel)— Less (Mai putine) (F7), More (Mai multe) (F8)
<informatii pe ecran>

B Tab—Overview, Test, Status, Log, Error (Fili—Prezentare
generald, Test, Stare, Jurnal, Eroare)

B Help—Contents, How to use Help, About (Ajutor—Continut,
Cum se utilizeazd Ajutorul, Despre)

Tool Bar (Bara de instrumente)—Pictograme pentru categorii
diferite de informatii

Sub bara de meniu, bara de instrumente contine un rand de
pictograme pentru fiecare dintre urmétoarele categorii de informatii
despre computer:

B Sistem—Informatii despre placa de sistem, despre memoria
ROM si despre datd si ord

B Control al activului—Informatii despre eticheta cu numarul de

inventar, despre numarul de serie al sistemului si despre procesor

Dispozitive de intrare—Informatii despre tastaturd, maus

si joystick-uri

Comunicatii—Port-uri din sistem si informatii despre fiecare

Stocare—Unititi de stocare din sistem si informatii despre fiecare

Grafici—Informatii despre sistemul grafic

Memorie—Informatii despre placa de sistem si despre memoria
din Windows

B Multimedia—Informatii despre stocarea opticd (CD, DVD etc.)
si despre sistemul audio

Windows—Informatii despre Windows
B Arhitecturi—Informatii despre dispozitivele PCI

Ghid de depanare
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Caracteristici de diagnosticare a computerelor

Resurse—Informatii despre IRQ-uri, despre intréri/iesiri
si despre maparea memoriei

Stare—Situatia temperaturii sistemului si a unitdtilor de disc

Diverse—CMOS, DMI, BIOS, sistem, nume produs $i numar
de serie

File—Overview, Test, Status, Log, Error (Prezentare generalg,
Test, Stare, Jurnal, Eroare)

Sub bara de instrumente se gasesc cinci file:

Overview—Fereastra Overview afiseaza informatii generale
despre computer. Aceasta este fereastra care se afiseazd la prima
pornire a programului utilitar. In partea din stdnga a ferestrei sunt
afisate informatii despre hardware, iar n partea dreaptd sunt
afisate informatii despre software.

Test—Fereastra Test vd permite sa selectati diferite componente
ale sistemului pentru a le testa. Aveti, de asemenea, posibilitatea
sd selectati tipul de test si modul de testare.

Status—Fereastra Status afiseazd starea fiecdrui test Tn desfasurare.
Aveti posibilitatea sd revocati testarea facand clic pe butonul
Cancel Testing (Revocare testare).

Log—Fereastra Log afiseaza un jurnal al testelor pentru fiecare
dispozitiv.
Error—Fereastra Error afiseazd toate erorile care survin in timpul

testérii dispozitivelor. In fereastri sunt listate dispozitivele care
se testeaza, tipurile si numarul de erori si codurile de eroare.

Executarea testelor de diagnosticare din programul
Diagnostics for Windows

Pentru a executa testele de diagnosticare:

1. Faceti clic pe Start > HP Information Center > Diagnostics

for Windows. Aveti, de asemenea, posibilitatea sd selectati
pictograma Diagnostics for Windows, situatd in Control Panel,
facand clic pe Start > Control Panel si selectind Diagnostics
for Windows.

Pe ecran se afiseazd prezentarea generala a hardware-ului
si software-ului computerului. Sub randul de pictograme sunt
afisate cinci file: Overview, Test, Status, Log si Error.
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Caracteristici de diagnosticare a computerelor

2. Faceti clic pe fila Test sau faceti clic 1n partea superioard
a ecranului pe Tab si selectati Test.

3. Selectati una dintre urmatoarele optiuni:

O Quick Test—Executa pentru fiecare dispozitiv un test rapid,
general. Daca este selectat Unattended Mode (Mod
nesupravegheat), nu este necesard nici o interventie din partea
utilizatorului.

0 Complete Test—Executa testarea maxima a fiecarui
dispozitiv. Utilizatorul poate si selecteze Interactive Mode
(Mod interactiv) sau Unattended Mode.

O Custom Test—Executd numai testele selectate. Pentru
a selecta anumite dispozitive sau teste, identificati
dispozitivul din listd, apoi selectati caseta de langé fiecare
test. Cand o casetd este selectatd, in aceasta se afiseaza un
semn de bifare de culoare rosie. Este posibil ca unele teste
selectate sa necesite interventia utilizatorului.

Pentru a testa toate subsistemele, trebuie sa va conectati ca administrator.
Daci nu vi conectati ca administrator, nu veti avea posibilitatea sa
testati unele subsisteme. Imposibilitatea de a testa un subsistem va fi
indicatd printr-un mesaj de eroare afisat sub numele subsistemului din
fereastra Test sau prin casete umbrite care nu se pot selecta.

4. Selectati Interactive Mode sau Unattended Mode. In modul
interactiv, software-ul de diagnosticare va va solicita date
de intrare in timpul testelor pentru care acestea sunt necesare.
Anumite teste necesitd interactiune si vor afisa erori sau vor
intrerupe testarea dacd sunt selectate in combinatie cu modul
nesupravegheat.

O Modul interactiv asigurd maximul de control in timpul
procesului de testare. Dumneavoastrad decideti daca testul
a reusit sau a esuat si vi se poate solicita sa introduceti sau
sd scoateti dispozitive.

3  In modul nesupravegheat nu sunt afisate solicitiri. Daci sunt
gdsite erori, acestea sunt afisate dupa terminarea testarii.

Ghid de depanare

www. hp.com 1-7



Caracteristici de diagnosticare a computerelor

5.

10.

11.

In partea inferioari a ferestrei, faceti clic pe butonul Begin
Testing (Incepere testare). Se afiseazi starea testirii,
prezentandu-se stadiul si rezultatul fiecarui test. Pentru mai multe
detalii despre executarea testelor, faceti clic pe fila Log sau
faceti clic n partea superioard a ferestrei pe Tab si selectati Log.

. Pentru a vedea un raport al testului, selectati o fila:

0 Fila Status prezintd un rezumat al testelor executate, reusite
si esuate in timpul sesiunii curente de testare.

0 Fila Log listeaza testele executate pe sistem, numarul
de executii ale fiecdrui test, numarul de erori gésite la fiecare
test si durata totala de executare a fiecarui test.

O Fila Error listeazi toate erorile gasite la computer impreund
cu codurile de eroare corespunzatoare.

. Pentru a salva un raport al testului:

O Pentru a salva un raport al filei Log, selectati fila Log,
butonul Save.

O Pentru a salva un raport al filei Error, selectati fila Error,
butonul Save.

. Pentru a imprima un raport al testului:

O Daca raportul este despre fila Log, selectati File > Save As,
apoi imprimati fisierul din folderul selectat.

0 Dacd raportul este despre fila Error, selectati fila Error,
butonul Print.

. Daca se gésesc erori, faceti clic pe fila Error pentru a afisa

informatii mai detaliate si actiuni recomandate. Daca urmati
actiunile recomandate, este posibil sd rezolvati personal anumite
probleme.

In cazul in care este necesar si luati legétura cu un distribuitor,
revanzator sau furnizor de servicii autorizat, faceti clic pe Print
sau salvati informatiile despre erori.

Pentru a iesi din programul Diagnostics for Windows, faceti clic
pe File, apoi faceti clic pe Exit.
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Caracteristici de diagnosticare a computerelor

Configuration Record

Programul utilitar Configuration Record (Inregistrare configuratie)

este un instrument Windows de culegere de informatii, similar cu alte
instrumente de gestionare. Acesta culege informatii critice despre
hardware si software de la diferite subsisteme ale computerului pentru

a obtine o imagine completa a acestuia. Configuration Record ofera
mijloace pentru identificarea automata si pentru compararea
modificarilor de configuratie si are capacitatea de a mentine un istoric al
configuratiei. Informatiile se pot salva ca un istoric al mai multor sesiuni.

Acest program utilitar a fost dezvoltat pentru a va permite sd rezolvati
problemele fird a deconecta computerul si pentru a va ajuta sa
maximizati disponibilitatea computerului. Informatiile obtinute prin
programul utilitar sunt utile pentru depanarea problemelor sistemului
si Indruma procesul de service, permitand identificarea rapida

si usoara a configuratiilor sistemului, ceea ce reprezinta primul pas
din rezolvarea situatiilor de cétre service.

Programul Configuration Record culege automat informatii despre
hardware si despre software-ul sistemului de operare pentru a pentru
a prezenta o imagine cuprinzitoare a sistemului. Acesta culege

si afiseazd informatii despre componente precum memoria ROM,
numarul de inventar, procesorul, unitétile fizice, dispozitivele PCI,
memoria, placa graficd, numirul de versiune a sistemului de operare,
parametrii sistemului de operare si fisierele de lansare a sistemului
de operare. Daca fisierul original Base.log este prezent in directorul
cpqdiags, fisierul Base.log se afiseaza alaturi de fisierul Now.log
intr-o fereastra scindati in care diferentele dintre cele doua fisiere
sunt evidentiate cu culoare rosie.

Ghid de depanare
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Caracteristici de diagnosticare a computerelor

Instalarea programului Configuration Record

Programul Configuration Record este o componentd a programului
Diagnostics for Windows. De fiecare datd cand instalati programul
Diagnostics for Windows, se instaleazd si programul
Configuration Record.

Executarea programului Configuration Record

AN

AN

Pentru a executa acest program:

1. Faceti clic pe Start > HP Information Center > Configuration
Record. Aveti, de asemenea, posibilitatea sa selectati pictograma
Configuration Record, situatd in Control Panel, facand clic pe
Start > Control Panel si selectind Configuration Record.

Programul Configuration Record are doua optiuni de vizualizare:
Show Changed Items Only (Afiseazd numai elementele modificate)
si Show All (Afiseaza toate elementele). Vizualizarea implicita este
Show Changed Items Only, de aceea tot textul este afisat Tn culoarea
rosie, deoarece prezintd numai diferentele. Prin comutarea la Show
All se afiseaza vizualizarea completa si cuprinzatoare a sistemului.

2. Vizualizarea implicita este Show Changed Items Only. Pentru
a vizualiza toate informatiile culese de programul Configuration
Record, faceti clic in partea superioar a ferestrei pe View si selectati
Show All sau faceti clic pe pictograma Show All Items.

3. Pentru a salva informatiile din fereastra din stinga sau din dreapta,
selectati File > Save Window File (Salvare fisier din fereastrd),
apoi selectati Left Window File (Fisier din fereastra din stanga)
sau Right Window File (Fisier din fereastra din dreapta).

Prin salvarea periodici a configuratiei computerului, utilizatorii pot
sd pastreze un istoric al configuratiei. Dacd sistemul intampind la un
moment dat o problemad care necesitd depanare, acest istoric poate
sa fie util pentru furnizorul de servicii.

4. Pentru a iesi din programul Configuration Record, faceti clic
pe File, apoi faceti clic pe Exit.
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Caracteristici de diagnosticare a computerelor

Protejarea software-ului

Pentru a proteja software-ul impotriva pierderii sau deteriorarii,
pastrati o copie de rezerva a Intregului sistem de operare, a aplicatiilor
si fisierelor legate de acestea, stocate pe unitatea de disc. Pentru
instructiuni despre modul de realizare a copiilor de rezerva pentru
fisierele de date, consultati documentatia sistemului de operare sau

a utilitarului pentru copiere de rezerva.

Restaurarea software-ului

Sistemul de operare Windows si software-ul se pot restaura la starea
originald pe care o aveau cind ati achizitionat computerul prin
utilizarea CD-ului Restore Plus! Consultati documentatia livratad
impreund cu CD-ul Restore Plus! pentru instructiuni complete despre
utilizarea acestei caracteristici.

Ghid de depanare
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Depanarea fara diagnosticare

ES

Acest capitol furnizeaza informatii despre modul de identificare si
de corectare a problemelor minore, precum cele legate de unitatea de
dischetd, unitatea de disc, unitatea opticd, placa graficd, placa audio,
memorie si software. Dacd aveti probleme cu computerul, consultati
tabelele din acest capitol pentru cauzele probabile si solutiile
recomandate.

Pentru informatii despre un anumit mesaj de eroare care poate
sd apard pe ecran in timpul testelor automate de la pornire (POST),
consultati Anexa A, ,,Mesaje de eroare ale testelor POST*.

Siguranta si confort

A\

AVERTISMENT: Utilizarea necorespunzdtoare a computerului sau
incapacitatea de a asigura un mediu de lucru sigur si confortabil poate
s& aibd ca rezultat lipsa de confort sau ranirea grava. Consultati
Safety & Comfort Guide (Ghid pentru sigurani& si confort), disponibil
pe Documentation CD si pe situl Web www.hp.com/ergo, pentru mai
multe informatii despre alegerea unui spatiu de lucru si crearea unui
mediu de lucru sigur si confortabil.

Acest echipament a fost testat si s-a constatat c& se incadreazd in limitele
pentru dispozitivele digitale din Clasa B, prevazute in partea a 15-a

a normelor FCC. Pentru mai multe informatii, consultati Informafii despre
norme si despre siguranfd de pe Documentation CD.

Ghid de depanare
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Depanarea férg diagnosticare

inainte de a apela asistenta tehnicé

Daci aveti probleme cu computerul, pentru a identifica exact
problema inainte de a apela la asistenta tehnicd, Tncercati solutia
corespunzdtoare dintre cele de mai jos.

Executati programul utilitar Diagnostics for Windows. Pentru mai
multe informatii, consultati Capitolul 1, ,,Caracteristici de
diagnosticare a computerelor®.

Executati testul Drive Protection System (DPS) din programul
Computer Setup. Pentru mai multe informatii, consultati
Ghidul programului utilitar Computer Setup (F10) de pe
Documentation CD.

Verificati LED-ul pentru alimentare de pe panoul frontal

al computerului pentru a vedea dacd clipeste cu culoare rosie.
Indicatoarele luminoase care clipesc reprezintd coduri de eroare
care v ajuta sa diagnosticati problema. Pentru mai multe informatii,
consultati Anexa A, ,,Mesaje de eroare ale testelor POST*.

Dacd pe ecran nu apare nimic, conectati monitorul la un alt port
video al computerului, dacd este disponibil. Ca variantd, inlocuiti
monitorul cu un monitor care stiti ca functioneaza corect.

Dacd lucrati 1n retea, conectati un alt computer si un alt cablu
la conexiunea de retea. Este posibil sd aveti o problemad cu
conectorul sau cu cablul de retea.

Dacd ati addugat recent hardware nou, scoateti hardware-ul
si verificati dacd computerul functioneaza corect.

Daca ati instalat recent software nou, dezinstalati software-ul
si verificati dacd computerul functioneaza corect.

Porniti computerul in Safe Mode (Mod protejat) pentru a vedea
daca porneste fard si incarce toate driverele. Cand se incarca
sistemul de operare, utilizati ,,L.ast Known Configuration*
(Ultima configuratie cunoscuta).

Consultati asistenta tehnica interactivd mai cuprinzdtoare,
la adresa www.hp.com/support.

Consultati sectiunea ,,Indicii utile* din acest ghid.

Executati CD-ul Restore Plus!.
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ATENTIE: Executarea CD-ului Restore Plus! va sterge toate datele
de pe unitatea de disc.

Pentru a va asista la rezolvarea interactivd a problemelor, programul
HP Instant Support Professional Edition va furnizeaza solutii de
diagnosticare automati. Dacd este necesar sd contactati asistenta HP,
utilizati caracteristica de chat interactiv a programului HP Instant
Support Professional Edition. Programul HP Instant Support
Professional Edition poate fi accesat la adresa: www.hp.com/go/ispe.

Pentru cele mai recente informatii interactive despre asistentd,
software si drivere, notificdri In timp real si despre comunitatea
internationald de experti si utilizatori HP, accesati centrul de asistentd
Business Support Center (BSC) la adresa
www.hp.com/go/bizsupport.

Daci devine necesar sd apelati serviciul de asistentd tehnicd, pregétiti
urmdtoarele aspecte pentru a avea siguranta cd apelul dvs. va fi tratat
corespunzator:

B Inainte de apel, asezati-vi in fata computerului.

B Notati numarul de serie al computerului, numarul de identificare
a produsului si numéirul de serie al monitorului.

B Alocati timp pentru depanarea problemei impreund cu un
tehnician de service.

B Scoateti orice hardware adaugat recent in sistem.
B Eliminati software-ul instalat recent.

B Executati CD-ul Restore Plus!.

ATENTIE: Executarea CD-ului Restore Plus! va sterge toate datele
de pe unitatea de disc.

>

Pentru informatii despre vanzdri si despre upgrade-uri ale certificatelor
de garantie (Care Packs), apelati furnizorul local de servicii sau
distribuitorul local.

g
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Indicii ut

le

Dacd intdmpinati probleme cu computerul, cu monitorul sau cu
software-ul, Tnainte de a efectua alte operatiuni, consultati lista
urmdtoare de sugestii generale:

Verificati daca computerul si monitorul sunt conectate
la o prizi electricd.

Verificati dacd comutatorul de selectare a tensiunii (la anumite
modele) este comutat pe tensiunea corespunzitoare zonei in care
va aflati (115 V sau 230 V).

Verificati daca computerul este pornit si dacd indicatorul luminos
verde este aprins.

Verificati daca monitorul este pornit si dacd indicatorul luminos
verde al acestuia este aprins.

Verificati LED-ul pentru alimentare de pe panoul frontal

al computerului pentru a vedea daci clipeste cu culoare rosie.
Indicatoarele luminoase care clipesc reprezintd coduri de eroare
care v ajuta sa diagnosticati problema. Pentru mai multe informatii,
consultati Anexa A, ,,Mesaje de eroare ale testelor POST*.

Dacd monitorul este intunecat, activati controalele pentru
luminozitate si contrast ale acestuia.

Tineti apdsatd orice tastd. Dacd sistemul emite un semnal sonor,
inseamnd cd tastatura functioneaza corect.

Aveti grija ca nici o conexiune prin cablu si nu fie sldbitd
sau incorecta.

Porniti computerul, apdsand pe orice tastd sau apdsand butonul

de alimentare. Dacd sistemul rdimane in modul de oprire
temporard, opriti computerul tinind apédsat butonul de alimentare
cel putin patru secunde, apoi apdsati din nou butonul de alimentare
pentru a reporni computerul. Dacd sistemul nu se opreste,
deconectati cablul de alimentare, asteptati cateva secunde, apoi
conectati-1 la loc. Dacd In programul Computer Setup este setatd
optiunea de pornire automatd in caz de intrerupere a alimentdrii,
computerul porneste din nou automat. Dacd nu porneste din nou,
apdsati butonul de alimentare pentru a porni computerul.
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A\

B Dupa ce instalati o placd de extensie sau o componenta optionala
care nu este plug-and-play, configurati din nou computerul.
Pentru instructiuni, consultati ,,Rezolvarea problemelor de
instalare a hardware-ului®.

B Verificati dacd au fost instalate toate driverele necesare pentru
dispozitive. De exemplu, daca utilizati o imprimanti, este necesar
un driver pentru modelul respectiv de imprimanta.

B Scoateti toate suporturile Incércabile (dischetd, CD sau dispozitiv
USB) din sistem inainte de a-1 porni.

B Daca ati instalat un alt sistem de operare decat cel instalat din
fabrica, verificati daca acesta este acceptat de sistem.

B Dacad in sistem sunt instalate mai multe surse video (incorporate
sau adaptoare PCI sau PCI-Express) — video incorporat exista
numai la anumite modele — si un singur monitor, monitorul
trebuie sd fie conectat Tn conectorul pentru monitor al sursei
selectate ca adaptor principal VGA. In timpul incércirii
sistemului, celelalte conectoare pentru monitor sunt dezactivate,
deci monitorul nu va functiona dacé este conectat la aceste
port-uri. Selectati care sursd VGA va fi cea principald, din
programul Computer Setup.

ATENTIE: Cand computerul este conectat la o sursd de curent alternativ,
la placa de sistem se aplica intotdeauna o tensiune. Inainte de a deschide
computerul, pentru a impiedica orice deteriorare a placii de sistem,
trebuie s& deconectati cablul de alimentare de la sursa de alimentare.

Ghid de depanare
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Rezolvarea problemelor generale

Aveti posibilitatea sd rezolvati usor problemele generale descrise in
aceastd sectiune. Dacd o problemad persistd si nu reusiti sd o rezolvati
singur sau efectuarea operatiunii va displace, contactati distribuitorul

autorizat.

Rezolvarea problemelor generale

Problema Cauza

Solutie

Computerul este aparent
blocat si nu se opreste
cand se apasa butonul
de alimentare.

Controlul prin software al
comutatorului de alimentare
nu functioneaza.

Tinefi apasat butonul de alimentare
cel putin patru secunde, pana céand
computerul se opreste.

Computerul nu
reactioneazd la tastatura
sau mausul USB.

Computerul este in modul
oprire temporara.

Apasati butonul de alimentare pentru
a iesi din modul oprire temporaré.

Sistemul s-a blocat.

Reporniti computerul.

ATENTIE: Cand incercati sa iesifi din modul oprire temporara, nu finefi apasat
butonul de alimentare mai mult de patru secunde. In caz contrar, computerul se va opri

si datele se vor pierde.

Computerul afiseaz&
incorect data si ora.

Este posibil s& fie necesars
inlocuirea bateriei RTC

(realtime clock — ceas

in timp real).

Conectarea computerului

la o priza de c.a.
prelungeste viata
bateriei RTC.

Mai intai, resetati data si ora din
Control Panel (pentru a actualiza
data si ora se poate utiliza si
programul Computer Setup). Dacé
problema persistd, inlocuiti bateria
RTC. Pentru instructiuni despre
instalarea unei baterii noi, consultati
Ghid de referin& hardware de pe
Documentation CD sau contactati un
distribuitor autorizat pentru a inlocui
bateria RTC.

Cursorul nu se misca
la utilizarea tastelor
sageli de pe tastatura.

Num Lock

Este posibil ca tasta

s& fie apasata.

Apasati tasta Num Lock. Indicatorul
luminos Num Lock nu trebuie sa fie
aprins cand utilizati tastele sageti.
Tasta Num Lock se poate dezactiva
(sau activa) din programul

Computer Setup.
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Rezolvarea problemelor generale (Continuare)

Problema

Cauza

Solutie

Capacul sau panoul
de acces la computer
nu se pot scoate.

Smart Cover Lock
(Dispozitiv de blocare
infeligentd a capacului),

cu care sunt dotate anumite
modele, este blocat.

Deblocati Smart Cover Lock utilizand
programul Computer Setup.

Cheia Smart Cover FailSafe, un
dispozitiv pentru dezactivarea manuald
a Smart Cover Lock, este disponibila de
la HP. Utilizarea cheii FailSafe este
necesard in cazul vitdrii parolei,
intreruperii alimentdrii sau functiondrii
necorespunzdatoare a computerului.
Comandati PN 166527-001 pentru
cheia stil cheie fixa sau PN 166527002
pentru cheia stil surubelnifa.

Sistemul functioneaza

cu performante reduse.

Procesoru| este Tncins.

1. Aveti grija s& nu fie blocat curentul
de aer spre computer.

2. Verificati dacé ventilatoarele sunt
conectate si functioneazd corect
(unele ventilatoare functioneazé&
numai cand este necesar).

3. Verificati daca radiatorul
procesorului este instalat corect.

Unitatea de disc este pling.

Transferati date de pe unitatea de disc
pentru a crea mai mult spatiu.

Memorie insuficientd.

Adaugati memorie suplimentarg.

Informatiile de pe unitatea
de disc sunt fragmentate.

Defragmentati unitatea de disc.

Programul accesat anterior
nu a eliberat memoria
rezervatd pentru a fi
utilizatd din nou de sistem.

Reporniti computerul.

Existd un virus pe unitatea

de disc.

Executati programul de protectie
impotriva virusilor.

Ghid de depanare
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Rezolvarea problemelor generale (Continuare)

Problema

Cauza

Solutie

Sistemul functioneaza
cu performante reduse.
(continuare)

Se executd prea multe
aplicatii.

1. Inchidefi aplicatiile care nu sunt
necesare pentru a elibera memorie.

2. Adaugati memorie suplimentara.

Cauzd necunoscutd.

Reporniti computerul.

Computerul s-a oprit
automat, LED-ul de
alimentare clipeste de
doud ori cu culoare rosie,
o data pe secundd, dupa
care urmeazd o pauzd
de doud secunde, iar
computerul emite doud
semnale sonore scurte.

Protectia termica
a procesorului este
activata:

Un ventilator este blocat
sau nu se roteste.
SAU

Radiatorul nu este atasat
corect la procesor.

1. Verificati daca orificiile de
ventilatie ale computerului nu sunt
blocate si daca ventilatorul de
récire a procesorului funclioneaza.

2. Deschideti capacul, apasati
butonul de alimentare si verificati
daca ventilatorul procesorului se
roteste. Dacé ventilatorul
procesorului nu se roteste, verificati
modul de conectare a cablului
ventilatorului la placa de sistem.
Verificati dacé& ventilatorul este
pozitionat si instalat corect.

3. Dacd ventilatorul este conectat

si pozifionat corect, dar nu se
roteste, inlocuiti-l.

4. Repozitionati radiatorul

procesorului si verificali daca
ansamblul ventilatorului este
atasat corect.

5. Contactati un distribuitor sau

furnizor de servicii autorizat.
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Rezolvarea problemelor generale (Continuare)

Problema

Cauza

Solutie

Sistemul nu porneste, iar  Sistemul nu se poate

LED-urile de pe panoul
frontal al computerului
nu clipesc.

alimenta.

Tinefi apasat butonul de alimentare
mai putin de patru secunde. Dacé
LED-ul unit&tii de disc se aprinde verde:

1. Verificati dacé selectorul de
tensiune, amplasat in partea
din spate a sursei de alimentare
la anumite modele, este setat
la tensiunea corespunzatoare.
Setarea corectd a tensiunii depinde
de regiunea in care va aflafi.

2. Scoateti pe rénd toate placile de
extensie, pan& cand se aprinde
indicatorul luminos 3V_aux de pe
placa de sistem.

3. Inlocuiti placa de sistem.

SAU

Tineti apasat butonul de alimentare mai
putin de patru secunde. Dac& LED-ul
unitafii de disc nu se aprinde verde:

1. Verificati dacd unitatea este
conectatd la o priza
de c.a. functionals.

2. Deschidefi capacul si verificati daca
firele butonului de alimentare sunt
conectate corect la placa de sistem.

3. Verificati dacd ambele cabluri ale
sursei de alimentare sunt conectate
corect la placa de sistem.

4. Verificati dacé indicatorul luminos
3V_aux de pe placa de sistem este
aprins. Dacd este aprins, inlocuiti
firele butonului de alimentare.

5. Dacd indicatorul luminos 3V_aux
de pe placa de sistem nu este
aprins, inlocuiti sursa de alimentare.

6. Inlocuiti placa de sistem.

Ghid de depanare
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Rezolvarea problemelor legate de sursa
de alimentare

Cele mai intalnite cauze si solutii pentru probleme legate de sursa
de alimentare sunt listate Tn tabelul urmator.

Rezolvarea problemelor legate de sursa de alimentare

Problema Cavuza Solutie

Sursa de alimentare Comutatorul de selectare  Selectati tensiunea de c.a.

se opreste intermitent. a fensiunii din spatele corespunzdtoare cu comutatorul
sasiului computerului de selectare.

(la anumite modele)
nu este comutat pe
tensiunea corectd a liniei

(TT5V sau 230 V).

Sursa de alimentare Contactati un furnizor de servicii
nu porneste datoritd unei autorizat pentru a inlocui sursa
defectiuni interne a sursei de alimentare.

de alimentare.
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Rezolvarea problemelor legate de sursa de alimentare (Continuare)

Problema

Cauza

Solutie

Computerul s-a oprit
automat, LED-ul de
alimentare clipeste de doua
ori cu culoare rosie, o datd
pe secundd, dupd care
urmeazd o pauzd de doud
secunde, iar computerul
emite doud semnale

sonore scurte.

Protectia termica
a procesorului este
activatd:

Un ventilator este blocat
sau nu se roteste.
SAU

Radiatorul nu este atasat
corect la procesor.

1. Verificati dacd orificiile de

ventilatie ale computerului nu sunt
blocate si dacd ventilatorul de
récire a procesorului funcfioneaza.

. Deschideti capacul, apasati

butonul de alimentare si
verificati dacd ventilatorul
procesorului se roteste. Daca
ventilatorul procesorului nu

se roteste, verificati modul

de conectare a cablului
ventilatorului la placa de sistem.
Verificati dacé ventilatorul este
pozifionat si instalat corect.

. Dacé ventilatorul este conectat

si pozifionat corect, dar nu se
roteste, inlocuiti-l.

. Repozitionati radiatorul

procesorului si verificali daca
ansamblul ventilatorului este
atasat corect.

. Contactati un distribuitor sau

furnizor de servicii autorizat.
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Rezolvarea problemelor legate de sursa de alimentare (Continuare)

Problema

Solutie

LED-ul de alimentare clipeste Eroare de alimentare

de patru ori cu culoare rosie, (sursa de alimentare este
suprasolicitatd).

o data pe secundd, dupa
care urmeazd o pauzd de
doud secunde, iar
computerul emite patru
semnale sonore.

1. Verificati dacé selectorul de

tensiune, amplasat in partea

din spate a sursei de alimentare
(la anumite modele), este setat

la tensiunea corespunzdtoare.
Setarea corectd a tensiunii depinde
de regiunea in care v& aflafi.

. Deschideti capacul si verificati

pozifionarea cablului de
alimentare cu 4 fire in conectorul
de pe placa de sistem.

. Verificati dacd problema este

generatd de un dispozitiv;
scoatefi TOATE dispozitivele
atasate (precum unitdtile de disc,
de dischetd sau optice si placile
de extensie). Porniti sistemul. Dacé&
sistemul intr& in testarile POST,
oprifil si repetali aceastd
procedurd monténd la loc,

pe rand, cate un dispozitiv,

péna cand apare defectiunea.
Inlocuiti dispozitivul care

a provocat defectiunea. Continuati
s& addugati cate un dispozitiv,
pentru a verifica dacd toate
dispozitivele funcfioneazé corect.

. Contactati un furnizor de servicii

autorizat pentru a inlocui sursa
de alimentare.

5. Tnlocuiti placa de sistem.
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Rezolvarea problemelor legate de discheta

Cele mai intalnite cauze si solutii pentru probleme legate de discheta
sunt listate Tn tabelul urmdtor.

% Cénd addugati sau eliminati hardware precum o unitate suplimentara
de dischetd, este posibil sa fie necesard reconfigurarea computerului.
Pentru instructiuni, consultati ,,Rezolvarea problemelor de instalare
a hardware-ului®.

Rezolvarea problemelor legate de discheta

Problema Cauza Solutie
Indicatorul luminos al unitdfii Discheta este defects. In Microsoft Windows XP, faceti clic
de dischetd raméane aprins. cu butonul din dreapta al mausului

pe Start, faceti clic pe Explore
(Explorare) si selectati o unitate.
Selectati File > Properties > Tools
(Fisier — Proprietdati — Instrumente).
Sub Error-checking (Verificare
erori), facefi clic pe Check Now
(Verificare acum).

Discheta nu este Scoateti discheta si introduceti-o
introdusd corect. din nou.

Cablul unitatii nu este Conectati din nou cablul unitatii.
conectat corect. Aveti grija ca tofi cei patru pini ai

cablului de alimentare a unitatii de
dischetd sa fie conectati la unitate.

Unitatea nu a fost gasita. Cablul este slabit. Repozifionati cablurile de date si de
alimentare ale unitdtii de dischetd.

Unitatea detasabild nu Repozitionati unitatea.
este pozitionata corect.
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Rezolvarea problemelor legate de discheta (Continuare)

Problema

Cauza

Solutie

Unitatea de dischetd nu
poate s& scrie pe o dischetd

Discheta nu este
. formatata.

Formatati discheta.

1. Din Windows Explorer,
selectati unitatea de disc (A).

2. Faceti clic cu butonul din dreapta
al mausului pe litera unitdtii
si selectati Format.

3. Selectati optiunile dorite, apoi
faceti clic pe Start pentru
a incepe formatarea dischetei.

Discheta este protejata
la scriere.

Utilizati o alté dischetd sau
eliminati protectia la scriere.

Se scrie pe o unitate
gresita.

Verificati litera de unitate din clauza
pentru cale.

Pe dischetd nu este spatiu
liber suficient.

1. Utilizati alta discheta.

2. Stergeti fisierele care nu mai sunt
necesare de pe dischetd.

Scrierile pe dischete

de firma sunt dezactivate
din programul
Computer Setup.

Intrafi in programul Computer Setup
si activati optiunea Legacy
Diskette Write (Scriere pe dischetd
de firma) in Storage > Storage
Options (Stocare — Optiuni

de stocare).

Discheta este defectd.

Inlocuiti discheta defectd.

Discheta nu se poate
formata.

S-a raportat un suport
nevalid.

Cand formatati un disc in MS-DOS,
este posibil sa fie necesar s&
specificai capacitatea dischetei.
De exemplu, pentru a formata

o dischet& de 1,44 MO, tastati
urmatoarea comandd la prompt-ul
MS-DOS:

FORMAT A: /F:1440

Este posibil ca discul
s& fie protejat la scriere.

Deschideti dispozitivul de blocare
de pe dischets.
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Rezolvarea problemelor legate de discheta (Continuare)

Problema Cauza Solutie

Discheta nu se poate Controlul de scriere pe  Intrafi in programul Computer Setup

formata. (continuare) dischetd este activat. si activati opfiunea Legacy
Diskette Write (Scriere pe dischetd
de firma) in Storage > Storage
Options (Stocare — Optiuni
de stocare).

A survenit o problemé& Structura de directoare  In Windows XP, faceti clic cu butonul

la o tranzactie cu discul. este gresitd sau existd din dreapta al mausului pe Start,

o problema cu un fisier.

faceti clic pe Explore (Explorare)
si selectati o unitate. Selectati File >
Properties > Tools (Fisier —
Proprietdti — Instrumente). Sub
Error-checking (Verificare erori),
faceti clic pe Check Now
(Verificare acum).

Unitatea de discheta Utilizati un alt tip
nu poate sd citeascd de discheta decat tipul
o discheta. unitatii de discheta.

Verificati ce tip de unitate utilizafi
si utilizati tipul corect de discheta.

Se citeste de pe o unitate
gresita.

Verificati litera de unitate din clauza
pentru cale.

Discheta este defecta.

Inlocuiti discheta cu una noua.

Se afiseaza mesajul ,Invalid A fost introdusa in unitate

system disk” (Disc de sistem o dischetd care nu

nevalid). contine fisierele de sistem
necesare pentru pornirea
computerului.

Cand se opreste activitatea unitdtii,
scoateti discheta si apdsati bara
de spativ Spacebar. Computerul
va porni.

A survenit o eroare
de discheta.

Reporniti computerul apdséand
pe butonul de alimentare.
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Rezolvarea problemelor legate de discheta (Continuare)

Problema

Cauza

Solutie

Sistemul nu poate fi incarcat
de pe dischets.

Discheta nu este
ncdrcabila.

Inlocuiti-o cu o dischetd incarcabils.

Incarcarea de pe dischetd
a fost dezactivata

din programul

Computer Setup.

1. Executati programul Computer
Setup si activati incarcarea
de pe dischetd in Storage >
Boot Order (Stocare — Ordine
de incarcare).

2. Executati programul Computer
Setup si activati incarcarea de
pe dischetd in Storage >
Storage Options >
Removable Media Boot
(Stocare — Opfiuni stocare -
Incarcare de pe suport amovibil).

Trebuie s& urmati améndoi pasii,
deoarece funcfiac Removable
Media Boot (Inc&rcare

de pe suport amovibil) din
Computer Setup ignord comanda
de activare Boot Order
(Ordine de incarcare).

Modul server

de retea este activat
din programul
Computer Setup.

Executati programul Computer Setup

si dezactivali Network Server
Mode din Security > Password
Options (Securitate — Opfiuni parold).

Incarcarea de pe suporturi
amovibile a fost
dezactivata din programul
Computer Setup.

Executati programul Computer Setup
si activali incdrcarea de pe dispozitive
amovibile in Storage > Storage
Options > Removable Media
Boot (Stocare — Optiuni de stocare —
Inc&rcare de suporturi amovibile).
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Rezolvarea problemelor legate de unitatea de disc

Rezolvarea problemelor legate de unitatea de disc

Problema Cauza

Solutie

Survine o eroare de unitate  Unitatea de disc are
de disc. sectoare defecte sau
s-a defectat.

1. In Windows XP, facefi clic cu
butonul din dreapta al mausului
pe Start, facefi clic pe Explore
(Explorare) si selectati o unitate.
Selectati File > Properties >
Tools (Fisier — Proprietati —
Instrumente). Sub
Error-checking (Verificare
erori), facefi clic pe Check
Now (Verificare acum).

2. Utilizati un program utilitar pentru
gasirea si blocarea utilizarii
sectoarelor defecte. Dacd este
necesar, formatati din nou
unitatea de disc.

Problema de tranzactie Structura de directoare
cu discul. este gresitd sau exista

o problem& cu un fisier.

In Windows XP, faceti clic cu butonul
din dreapta al mausului pe Start,
faceti clic pe Explore (Explorare)

si selectati o unitate. Selectati File >
Properties > Tools (Fisier —
Proprieté&ji — Instrumente).

Sub Error-checking (Verificare
erori), facefi clic pe Check Now
(Verificare acum).
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Rezolvarea problemelor legate de unitatea de disc (Continuare)

Problema

Cauza

Solutie

Unitatea nu a fost gésitd
(identificata).

Cablul poate fi slabit.

Verificati conexiunile prin cablu.

Este posibil ca sistemul
sd nu recunoascd
automat un dispozitiv
nou instalat.

Consultati indruméarile pentru
reconfigurare din secfiunea
,Rezolvarea problemelor de instalare
a hardware-ului”. Dacé sistemul

tot nu recunoaste noul dispozitiv,
verificati daca dispozitivul este listat
in programul Computer Setup. Daca
este listat, este posibil ca problema
s& fie de la un driver. Dacd nu este
listat, este posibil ca problema sa fie
de hardware.

Dacé este vorba de o unitate

nou instalatd, intrafi in programul
Computer Setup si incercatfi s&
addugati o intarziere a testelor POST
sub Advanced > Power-On
(Avansat — Pornire).

Este posibil ca setarile
de jumper ale unitatii
s& fie incorecte.

Dacé unitatea este Master
(Principald), setati jumper-ul din
spatele unitafii pe Master sau pe
Cable Select. Daca unitatea este
Slave (Subordonata), setafi jumper-ul
pe Slave sau Cable Select.

Controlerul unitdtii este
dezactivat din programul
Computer Setup.

Executati programul Computer Setup
si activati toate controlerele IDE

si SATA in Storage > Storage
Options (Stocare — Optiuni

de stocare).

Unitatea raspunde incet
imediat dupd pornire.

Executati programul Computer Setup
si cresteti POST Delay (Intarziere teste
automate la pornire) in Advanced >
Power-On Options (Avansatf —
Optiuni la pornire).
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Rezolvarea problemelor legate de unitatea de disc (Continuare)

Problema Cauza Solutie
Apare mesajul Nonsystem  Sistemul incearca s& Scoateti discheta din unitatea
disk/NTLDR missing (Lipsé  porneasca de pe de discheta.
disc sistem/incarcator NT). o dischetd care nu este
incarcabila.
Sistemul incearcé sa 1. Introduceti o discheté& incarcabila
porneascd de pe in unitatea de discheta
unitatea de disc, dar si reporniti computerul.
unitatea de disc 2. Verificati formatul unitatii de disc

este defectd. cu programul FDISK:

Dacd formatul este NFTFS,
pentru a evalua unitatea utilizati
un cititor de la alt furnizor.
Dacé formatul este FAT32,
unitatea de disc nu poate

fi accesatd. Inlocuiti

imaginea MBR.

3. Daca unitatea de disc continua
s& fie inaccesibila si dupa
incarcarea de pe dischetd
si securitatea MBR Security
este activatd, incercafi sa
restaurafi imaginea MBR
salvatd anterior. In acest scop,
intrafi in programul Computer
Setup si selectali Security >
Restore Master Boot Record
(Securitate — Restaurare imagine
principalé de incarcat).
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Rezolvarea problemelor legate de unitatea de disc (Continuare)

Problema Cauza

Solutie

Apare mesajul Nonsystem  Fisierele de sistem
disk/NTLDR missing (Lipsé@  lipsesc sau nu sunt
disc sistem/incarcator NT).  instalate corect.
(continuare)

1. Introduceti o discheté incarcabila
in unitatea de discheta
si repornifi computerul.

2. Verificati formatul unitatii
de disc cu programul FDISK:
Dacd formatul este NFTFS,
pentru a evalua unitatea utilizati
un cititor de la alt furnizor.
Dacé formatul este FAT32,
unitatea de disc nu poate
fi accesatd. Inlocuiti
imaginea MBR.

Dacé unitatea de disc continug sé
fie inaccesibila si dupa incarcarea
de pe dischetd si securitatea MBR
Security este activatd, incercati

sa restaurati imaginea MBR

salvatd anterior. In acest scop,
intrafi in programul Computer Setup
si selecta}i Security > Restore
Master Boot Record (Securitate —
Restaurare imagine principald

de incércat).

Incarcarea de pe
unitatea de disc
a fost dezactivata
din programul
Computer Setup.

Executati programul Computer Setup
si activati opfiunea unitdtii de disc
din lista Storage > Boot Order
(Stocare — Opfiuni de incarcare).

Unitatea de disc
incarcabild nu este
atasatd ca prima intr-o
configuratie cu mai multe
unitati de disc.

Dacd se incearcd incarcarea
sistemului de pe o unitate de disc IDE,
aveli grij& ca aceasta s fie atasata
ca Primary Device 0. Dacé se
incearcd incdrcarea sistemului de pe
o unitate de disc SATA, avefi grija
ca aceasta sd fie atasatd la SATA O.
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Rezolvarea problemelor legate de unitatea de disc (Continuare)

Problema Cauza

Solutie

Apare mesajul Nonsystem  Controlerul unitafii
disk/NTLDR missing (Lipsé  de disc incarcabile
disc sistem/incarcator NT).  nu este listat primul
(continuare) in Boot Order.

Intrafi in programul Computer Setup
si selecta}i Storage > Boot Order
(Stocare — Ordine de incdrcare)

si verificati dacé controlerul unit&tii
de disc incdrcabile este listat imediat

sub Hard Drive.

Unitatea de disc Parallel ATA  Utilizati un alt cablu
(PATA) nu functioneaza optim. decét cel al unitdtii.

Instalati din nou unitatea de disc Ultra
ATA, utilizénd un cablu cu 80 de fire.

Computerul nu porneste. Unitatea de disc este
defects.

Observati dacd LED-ul de alimentare
de pe panoul frontal clipeste

cu culoarea rosie si dacd se aud
semnale sonore. Pentru a determina
cauzele posibile corespunzatoare
codurilor semnalelor sonore si ale
celor care clipesc cu culoare rosie,
consultati Anexa A, ,Mesaje de
eroare ale testelor POST”.

Consultati termenii si conditiile
din Worldwide Limited Warranty
(Garantie limitatd pe plan
international).

Computerul este Programul in curs de
aparent blocat. utilizare nu mai r&spunde
la comenzi.

Incercati procedura de inchidere
normald , Shut Down” din Windows.
Dacd aceasta nu reuseste,

apésafi butonul de alimentare timp
de patru secunde sau mai mult pentru
a opri alimentarea. Pentru a reporni
computerul, apdsati din nou butonul
de alimentare.
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Rezolvarea problemelor legate de MultiBay

Rezolvarea problemelor legate de MultiBay

Problema

Cauza

Solutie

Unitatea nu a fost gasita.

Ati incercat sa
conectati o unitate

de disc amovibil& care
are activatd securitatea
Drivelock. (Aceast&
caracteristicd este
acceptat& numai

la anumite modele.)

Inchideti sistemul Windows

si opriti computerul. Daca nu este
deja introdusd, introduceti unitatea
in MultiBay. Porniti computerul.

in programul
Computer Setup,
MultiBay este ascuns.

Intrai in programul Computer Setup
si setafi MultiBay pe Device
Available (Dispozitiv disponibil)
in Security > Device Security
(Securitate — Securitate dispozitiv).

Rezolvarea problemelor legate de afisare

Dacd intalniti probleme legate de afisare, consultati documentatia
livratd Tmpreund cu monitorul si cauzele si solutiile cele mai intalnite,
listate Tn tabelul urmator.

Rezolvarea problemelor legate de afisare

Problema

Cavuza

Solutie

Ecran gol (fara
semnal video).

Monitorul nu este pornit,
iar indicatorul luminos
al monitorului nu

este aprins.

Porniti monitorul si verificati dacé
indicatorul luminos al monitorului
este aprins.

Monitor defect.

Incercati un alt monitor.

Conexiunile cablurilor
nu sunt corecte.

Verificafi conexiunea prin cablu
de la monitor la computer si cea
pand la priza electrica.
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Rezolvarea problemelor legate de afisare (Continuare)

Problema

Cauza

Solutie

Ecran gol (fara
semnal video). (continuare)

Este posibil sa avefi
instalat un program utilitar
pentru golirea ecranului
sau sd fie activate
caracteristicile de
economisire a energiei.

Apasati orice tastd sau facefi clic
cu mausul si, dacd este stabilitd,
introduceti parola.

Memoria ROM

a sistemului este defectd;
sistemul se executd in
modul FailSafe Boot
Block (Bloc de incarcare
FailSafe, indicat prin opt
semnale sonore).

Curatati din nou memoria ROM,
utilizand o dischetd ROMPagq. Pentru
mai multe informatii, consultati
sectiunea ,Memoria ROM a blocului
de incarcare FailSafe” din Ghid de
gestionare a computerului de pe
Documentation CD.

Utilizati un monitor
cu sincronizare fixd,
iar acesta nu se va
sincroniza la rezolutia
selectatd.

Verificati dacd monitorul acceptd
aceeasi rat& de scanare orizontald
ca si rezolutia selectatd.

Computer este in modul
oprire temporara.

Apésati butonul de alimentare pentru
a iesi din modul oprire temporara.

ATENTIE: Cand incercati sa iesifi din modul oprire temporara, nu finefi apasat
butonul de alimentare mai mult de patru secunde. In caz contrar, computerul se va opri

si datele se vor pierde.

Cablul monitorului
este conectat intr-un
conector gresit.

Daca sistemul computerului un
conector de placa grafica integrata

si un conector de placa grafica
addugatd, conectati cablul monitorului
in conectorul placii grafice ad&ugate
din spatele computerului.

Dacé placa grafica este o placa
de extensie PCl standard, placa
graficd integratd poate fi activatd
in programul Computer Setup.
Dacd este instalatd o placa grafica
PCl-Express, placa grafica integrata
nu poate fi activata.
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Rezolvarea problemelor legate de afisare (Continuare)

Problema

Cauza

Solutie

Ecran gol (fara
semnal video). (continuare)

Setarile pentru monitor
din computer nu sunt

compatibile cu monitorul.

1

. Reporniti computerul si

apasati F8 in timpul pornirii,
atunci cand apare mesaijul ,Press
F8“ in colful din dreapta-jos

al ecranului.

. Cu ajutorul tastelor sagefi ale

tastaturii, selectati Enable VGA
Mode (Activare mod VGA)
si apasati pe Enter.

. In Control Panel (Panou

de control) din Windows,

faceti dublu clic pe pictograma
Display (Afisare) si selectati fila
Settings (Setari).

4. Pentru a reseta rezolutia,
utilizati controlul glisant.
Ecranul este gol si LED-ul de  Eroare inaintea 1. Repozitionati modulele DIMM.
alimentare clipeste de cinci  memoriei video. Porniti sistemul.
or cu cu|g?r(zrosvle, o dafd 2. Pentru a identifica modulul
pe secunda, dupa care defect, inlocuiti pe rand
urmeaz& o pauz& de doud modulele DIMM
secunde, iar computerul 3. Tlocuit o del
emite cinci semnale sonore. - Inlocuifi memoria de la
alti furnizori cu memorie de la HP.
4. Inlocuiti placa de sistem.

Ecranul este gol si LED-ul de
alimentare clipeste de sase
ori cu culoare rosie, o daté
pe secundd, dupé care

urmeaz& o pauzd de doud
secunde, iar computerul

emite sase semnale sonore.

Eroare inainte de placa
grafica video

Pentru sistemele cu o placa grafica:

1.

2.
3.

Repozitionati placa grafica.
Porniti sistemul.

Inlocuiti placa grafica.

Inlocuiti placa de sistem.

Pentru sistemele cu placa grafica
integratd, inlocuiti placa de sistem.
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Rezolvarea problemelor legate de afisare (Continuare)

Problema

Cauza

Solutie

Ecranul este gol si LED-ul de
alimentare clipeste de sapte
ori cu culoare rosie, o datd
pe secundd, dupd care
urmeazd o pauzd de doud
secunde, iar computerul
emite sapte semnale sonore.

Defectiune la placa

de sistem (memoria ROM
a detectat o defectiune
inainte de placa video).

Inlocuiti placa de sistem.

Monitorul nu functioneazé
corect atunci cand este
utilizat cu caracteristici de
economisire a energiei.

Un monitor fara
capacitdti de economisire
a energiei este utilizat

cu caracteristicile

de economisire

a energiei activate.

Dezactivati caracteristica
de economisire a energiei.

Caractere intunecate.

Controalele de
luminozitate si contrast
nu sunt setate corect.

Reglati controalele de luminozitate
si contrast ale monitorului.

Cablurile nu sunt
conectate corect.

Verificati dacé este conectat ferm
cablul video, atét la placa grafics,
cét si la monitor.

Imaginea video este patata
sau nu se poate seta
rezolutia cerutd.

Dacd afi facut upgrade
al controlerului placii
grafice, este posibil sa
nu fie incarcate driverele
grafice corecte.

Instalati driverele video incluse
in pachetul de upgrade.

Monitorul nu poate
sd afiseze la rezolutia
solicitatd.

Schimbati rezolutia solicitata.

Placa grafica
este defectd.

Inlocuiti placa grafica.
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Rezolvarea problemelor legate de afisare (Continuare)

Problema

Cauza

Solutie

Imaginea este intreruptd,
se deruleazd, tremurd
sau clipeste.

Conexiunile monitorului
nu sunt complete

sau monitorul este
reglat incorect.

1. Verificati dacé afi conectat ferm
cablul monitorului la computer.

2. Dacd aveti un sistem cu doud
monitoare sau daca un alt
monitor este Tn apropiere,
verificati dacd monitoarele
nu interfereaza unul cu altul
in campul electromagnetic,
deplasandu-le.

3. Este posibil sa avefi lampi
fluorescente sau ventilatoare prea
aproape de monitor.

Monitorul trebuie
demagnetizat.

Demagpnetizati monitorul. Pentru
instructiuni, consultati documentatia
livratd impreund cu monitorul.

Cand porniti un monitor
CRT, acesta vibreazd sau
se aude un tiuit.

Bobina de demagnetizare
a monitorului
a fost activatd.

Fara. Este normal ca bobina
de demagnetizare s& se activeze
la pornirea monitorului.

Din interiorul unui monitor
CRT se aud clicuri.

S-au activat relee
electronice din interiorul
monitorului.

Fara. La anumite monitoare clicurile
sunt normale la pornire si oprire,

la intrarea sau iesirea in/din modul
de oprire temporard sau cand se
modificé rezolutia.

Din interiorul unui monitor
cu panou plat se aude un
tivit subtire.

Setdrile pentru
luminozitate si/sau
contrast sunt prea
ridicate.

Cobordti setérile de luminozitate
si/sau contrast.
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Rezolvarea problemelor legate de afisare (Continuare)

Problema

Cauza

Solutie

Focus neclar; dungi, dubluri
sau umbre; linii orizontale
care se deruleazd; dungi
verticale neclare; incapacitate
de a centra imaginea pe
ecran. (numai pentru
monitoarele cu ecran plat
care utilizeaza o conexiune

de intrare VGA analog)

Este posibil ca circuitele
de conversie digitala din
interiorul monitorului

cu ecran plat s8 nu
reuseascd sd interpreteze
corect sincronizarea de
iesire a placii grafice.

1.

Selectati opfiunea de
auto-reglare din meniul afisabil
pe ecranul monitorului.

. Sincronizati manual functiile

de afisare Clock si Clock Phase.
Pentru a descdrca un pachet
software SoftPaq care s& va
asiste la sincronizare, mergeti

la situl Web urmétor,

selectati monitorul corespunzator
si descarcati pachetul SP20930,
fie SP22333:
www.hp.com/support

Placa grafica nu este
pozifionatd corect sau
este defectd.

1

. Repozitionati placa grafica.

2. Inlocuiti placa grafica.

Anumite simboluri tastate
nu apar corect.

Fontul pe care il
utilizati nu accepta
simbolul respectiv.

Pentru a gési si a selecta simbolul
respectiv, utilizafi programul
Character Map. Faceti clic

pe Start > All Programs >
Accessories > System Tools >
Character Map. Simbolul poate
fi copiat din Character Map intr-un
document.
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Rezolvarea problemelor legate de sunet

Dacd computerul dispune de caracteristici de sunet si intdmpinati
probleme legate de sunet, consultati cauzele si solutiile cele mai
Intalnite, listate in tabelul urmator.

Rezolvarea problemelor legate de sunet

Problema

Cavza

Solutie

Sunetul are intreruperi.

Resursele procesorului
sunt utilizate de alte
aplicatii deschise.

Obpriti toate aplicatiile deschise care
utilizeaza intens procesorul.

Intérziere a sunetului
direct, existentd in mai

multe aplicatii de redare.

in Windows XP:

1. Din Control Panel, selectafi
Sounds and Audio Devices
(Sunete si dispozitive audio).

2. In fila Audio, selectati un
dispozitiv din lista Sound
Playback (Redare sunet).

3. Faceti clic pe butonul
Advanced si selectdti fila
Performance.

4. Setafi indicatorul glisant
Hardware acceleration
pe None si indicatorul Sample
rate conversion quality
pe Good, apoi testafi din
nou sunetul.
Setati indicatorul glisant Hardware
acceleration pe Full si indicatorul
Sample rate conversion quality
pe Best, apoi testafi din nou sunetul.

Sunetul nu se aude in
difuzoare sau in césti.

Controlul software al
volumului este oprit.

Faceti dublu clic pe pictograma
Difuzor din bara de activitdi, apoi
asigurafi-va cd opfiunea Mute nu este
selectatd si utilizati indicatorul glisant
pentru a regla volumul.

in programul Computer
Setup, optiunea Audio
(Sunet) este ascunsa.

Activati sunetul din programul
Computer Setup: Security > Device
Security > Audio (Securitate —
Securitate dispozitiv — Sunet).
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Rezolvarea problemelor legate de sunet (Continuare)

Problema

Cauza

Solutie

Sunetul nu se aude in

difuzoare sau in cé&sti.

(continuare)

Difuzoarele externe
nu sunt pornite.

Porniti difuzoarele externe.

Difuzoarele externe sunt
conectate la un jack
audio gresit.

Pentru conectarea corespunzatoare
a difuzoarelor, consultati
documentatia placii de sunet.

Nu este activat sunetul
pentru CD-uri digitale.

Activati sunetul pentru CD-uri digitale:

1. Din Control Panel,
selectati System.

2. In fila Hardware, facefi clic
pe butonul Device Manager
(Manager dispozitive).

3. Facefi clic cu butonul din dreapta
al mausului pe dispozitivul
CD/DVD si selectati Properties
(Proprietati).

4. In fila Properties, avefi grija
s& fie bifatd opfiunea ,Enable
digital CD audio for this
CD-ROM device” (Activare
sunet CD digital pentru acest
dispozitiv CD-ROM).

Castile sau dispozitivele
conectate la iesirea pldcii
de sunet anuleaza
difuzorul intern.

Porniti si utilizati céstile sau difuzoarele
externe, dacd sunt conectate, sau
deconectati castile sau difuzoarele
externe.

Volumul este anulat.

1. Din programul Control Panel,
faceti clic pe Sound, Speech
and Audio Devices, apoi
faceti clic pe Sounds and
Audio Devices (Sunete
si dispozitive audio).

2. Faceti clic pe caseta de validare
Mute pentru a elimina
bifarea acesteia.
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Rezolvarea problemelor legate de sunet (Continuare)

Problema Cauza Solutie

Sunetul nu se aude in Computerul este in modul  Apasati butonul de alimentare pentru
difuzoare sau in casti. oprire temporara. a iesi din modul oprire temporara.
(continuare)

ATENTIE: Cand incercati sa iesifi din modul oprire temporaré, nu finefi apasat
butonul de alimentare mai mult de patru secunde. In caz contrar, computerul se va opri
si datele se vor pierde.

in difuzoare sau in casti se  Este posibil ca computerul 1. Daca utilizati difuzoare digitale

aude zgomot sau nu se aude  s& nu detecteze tipul care au un jack stereo si dorifi
nici un sunet. corect de difuzor/casca ca sistemul s& fie comutat
sau sensul automat automat pe digital, utilizati un
analog-digital nu adaptor stereo-mono pentru
este angajat. a angaja corect caracteristica

auto-sense (sens automat).

2. Daca nu este disponibil un
adaptor stereo-mono, pentru
a comuta manual semnalul audio
din analog in digital utilizati
proprietdtile dispozitivului
multimedia.

3. Daca setul de casti are un jack
mono, pentru a comuta sistemul
pe iesire analogica utilizafi
proprietdtile dispozitivului
multimedia.

Pentru informatii despre cum se
schimba Output Mode (Modul
de iesire) audio, consultati Anexa D,
,Configurarea iesirilor audio
analogice/digitale”
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Rezolvarea problemelor legate de sunet (Continuare)

Problema Cauza Solutie

@y, Daca Output Mode este setat pe digital, difuzorul intern si difuzoarele externe
analogice nu vor mai emite semnale audio pand cénd comutati inapoi pe un mod
cu sens automat sau analog.

Daca Output Mode este setat pe analog, difuzoarele digitale externe nu vor functiona
pénd cand comutali modul de iesire inapoi pe un mod cu sens automat sau digital.

Pentru mai multe informatii, consultati Anexa D, , Configurarea iesirilor audio
analogice/digitale”.

Computerul este aparent Este posibil ca discul Inainte de a inregistra, aveti grija sa
blocat in timpul s& fie plin. existe spatiu liber suficient pe unitatea
inregistrarii audio. de disc. De asemeneq, se poate

incerca inregistrarea fisierului audio
intr-un format comprimat.

Rezolvarea problemelor legate de imprimanta

Dacd intalniti probleme legate de imprimantd, consultati
documentatia livratd impreund cu imprimanta si cauzele si solutiile
cele mai Intélnite, listate in tabelul urmator.

Rezolvarea problemelor legate de imprimanta

Problema Cauza Solutie

Imprimanta nu imprima. Imprimanta nu este Porniti imprimanta si verificati daca
pornitd si conectatd. este conectatd.
In aplicatie nu sunt 1. Instalati driverul corect pentru
instalate driverele corecte imprimantd, pentru aplicatie.

pentru imprimanta. 2. Incercati s& imprimati utilizénd

comanda MS-DOS:
DIR C:\ > [port imprimantda]

unde [port imprimanta] este
adresa imprimantei care se
utilizeazd. Dacd imprimanta
functioneazé, incércati din nou
driverul imprimantei.
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Rezolvarea problemelor legate de imprimanta (Continuare)

Problema Cauza Solutie

Imprimanta nu imprima. Dacé lucrati in refeq, este  Faceti conexiunile de refea necesare

(continuare) posibil s& nu fifi conectat pentru imprimanta.
cu imprimanta.

Este posibil ca Executati testarea automata
imprimanta sa fie defecta. a imprimantei.

Imprimanta nu porneste. Este posibil s& nu fie Conectati din nou toate cablurile
conectate corect si verificati cablul de alimentare
cablurile. si priza electrica.

Imprimanta imprimé& in aplicatie nu este Instalati driverul corect pentru

informatii distorsionate. instalat driverul corect imprimantd, pentru aplicatie.
pentru imprimantd.

Este posibil sa nu fie Conectati din nou toate cablurile.
conectate corect

cablurile.

Memoria imprimantei Resetati imprimanta prin oprirea
poate fi supraincarcatd. ei timp de un minut si repornire.

Imprimanta este Este posibil ca Verificati tava imprimantei

deconectats. imprimanta s& fi ramas  si alimentati-o daca este goals.
fara hartie. Selectati conectarea.
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Rezolvarea problemelor legate de tastatura
si de maus

Dacd intalniti probleme legate de tastaturd sau de maus, consultati
documentatia livratd impreund cu echipamentul si cauzele si solutiile
cele mai intalnite, listate Tn tabelul urmator.

Rezolvarea problemelor legate de tastatura

Problema Cauza Solutie

Tastele si comenzile de la Conectorul tastaturii 1. Din spatiul de lucru Windows,
tastaturd nu sunt recunoscute  nu este conectat corect. faceti clic pe Start.

de computer. 2. Facefi clic pe Shut Down

(Inchidere). Se afiseaza caseta de
dialog Shut Down Windows

~

(Inchidere Windows).
3. Selectati Shut Down.

4. Dupd inchiderea complets,
conectati astatura in spatele
computerului si repornifi

computerul.
Programul in curs Inchideti computerul utilizand
de utilizare nu mai mausul, apoi repornifi computerul.
raspunde la comenzi.
Tastatura trebuie Consultati termenii si conditiile
reparatd. din Worldwide Limited Warranty

(Garantie limitata pe plan
international).

Computerul este in modul  Apasati butonul de alimentare
oprire temporara. pentru a iesi din modul
oprire temporara.

A ATENTIE: Cand incercati sa iesifi din modul oprire temporard, nu finefi apasat
butonul de alimentare mai mult de patru secunde. In caz contrar, computerul se va opri
si datele se vor pierde.

Cursorul nu se misca la Este posibil ca tasta Apasati tasta Num Lock. Indicatorul
utilizarea tastelor sageti Num Lock ss luminos Num Lock nu trebuie sa fie
de pe tastatura. fie apasata. aprins céand utilizafi tastele sagefi.

Este posibil ca tasta Num Lock
s& fie ap&satd (sau activatd)
in Computer Setup.
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Rezolvarea problemelor legate de maus

Problema Cauza Solutie

Mausul nu raspunde la Conectorul mausului nu Inchideti computerul de la tastatura.

miscare sau este prea lent.  este conectat corect in 1. Apasati simultan tastele Ctrl
spatele computerului. si Esc (sau apasali tasta sigla

Windows) pentru a se afisa
meniul Start.

2. Utilizati tastele s&geatd in sus sau
sageatd in jos pentru a selecta
Shut Down (Inchidere), apoi
apdsati tasta Enter.

3. Utilizati tastele sdgeatd in sus sau
s&geatd in jos pentru a selecta
opfiunea Shut Down. apoi
apasati tasta Enter.

4. Dupa inchiderea complets,
conectati conectorul mausului
in spatele computerului (sau in
tastaturd) si repornifi computerul.

Programul in curs de Inchideti computerul de la tastatura
utilizare nu mai raspunde  si reporniti-l.

la comenzi.

Este posibil sa fie Scoateti capacul bilei mausului
necesard curdiarea si curdfati componentele interne.
mausului.

Este posibil sa Consultati termenii si conditiile din

fie necesara Worldwide Limited Warranty (Garantie
repararea mausului. limitata pe plan international).

Computerul este in modul  Apasati butonul de alimentare pentru
oprire temporara. a iesi din modul oprire temporara.

ATENTIE: Cand incercati sa iesifi din modul oprire temporaré, nu finefi apasat
butonul de alimentare mai mult de patru secunde. In caz contrar, computerul se va opri
si datele se vor pierde.

Mausul se mutd numai pe  Bila mausului este Scoateti capacul bilei din spatele
verticald, pe orizontald sau  murdara. mausului si curdjati-o cu un pachet
miscarea este dezordonata. de curafare disponibil la majoritatea

magazinelor de computere.
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Rezolvarea problemelor de instalare
a hardware-ului

Cand adiugati sau eliminati hardware, precum o unitate suplimentare
sau o placi de extensie, este posibil sd fie necesara reconfigurarea
computerului. Dacd instalati un dispozitiv plug-and-play, Windows XP
recunoaste dispozitivul si configureazd computerul Tn mod automat.
Dacid instalati un dispozitiv care nu este plug-and-play, dupa
finalizarea instaldrii hardware-ului nou trebuie sa reconfigurati
computerul. In Windows XP, utilizati Add Hardware Wizard
(Expert addugare hardware) si urmati instructiunile care apar pe ecran.

Rezolvarea problemelor de instalare a hardware-ului

Problema

Cavza

Solutie

Un dispozitiv nou nu este
recunoscut ca parte
a sistemului.

Dispozitivul nu
este pozifionat sau
conectat corect.

Verificati dacd dispozitivul este
conectat ferm si in pozifia corectd
si dacd nici un pin al conectorului
nu este indoit.

Cablul (cablurile) noului
dispozitiv extern sunt
slabite sau cablurile

de alimentare nu sunt
conectate.

Verificati dacé toate cablurile sunt
conectate ferm si in pozitia corectd
si dacd nici un pin al cablului sau
al conectorului nu este indoit.

Comutatorul de alimentare
al noului dispozitiv extern
nu este pornit.

Opriti computerul, porniti dispozitivul
extern, apoi porniti computerul pentru
a integra dispozitivul in sistem.

Cand sistemul v-a
recomandat modificari
ale configuratiei, nu
le-afi acceptat.

Reporniti computerul
si urmati instructiunile pentru
a accepta modificarile.

Daca configuratia
implicitd intr& in conflict
cu alte dispozitive, este
posibil ca o placa
plug-and-play s& nu se
configureze automat cénd
este adaugatd.

Utilizati Device Manager (Manager
dispozitive) din Windows XP pentru

a deselecta sefarile automate pentru
placd si optafi pentru o configurafie de
baza care nu provoacd un conflict intre
resurse. Pentru a rezolva conflictul dintre
resurse, se poate utiliza si programul
Computer Setup pentru reconfigurarea
sau dezactivarea dispozitivelor.
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Rezolvarea problemelor de instalare a hardware-ului (Continuare)

Problema

Cauza

Solutie

Computerul nu porneste.

S-au utilizat module
de memorie
necorespunzdatoare
pentru upgrade sau
modulele de memorie

1

. Pentru a determina dacd

utilizati modulele de memorie
corespunzdtoare si pentru

a verifica dacé sunt instalate
corect, consultati documentatia

au fost instalate intro
amplasare gresita. 2.

livratd impreund cu sistemul.

Observati semnalele sonore

si LED-urile de pe panoul frontal

al computerului. Pentru

a determina cauzele posibile,

consultati Anexa A, ,Mesaje de

eroare ale testelor POST”.

3. Daca problema nu se rezolva
nici astfel, contactati asistenta
pentru clienti.

LED-ul de alimentare clipeste  Memoria este instalata 1
de cinci ori cu culoare rosie, incorect sau este defectd.

o data pe secundd, dupa 2
care urmeazd o pauzd de
doud secunde, iar
computerul emite cinci
semnale sonore.

. Repozitionati modulele DIMM.
Porniti sistemul.

. Pentru a identifica modulul defect,
inlocuiti pe rénd modulele DIMM.

3. Inlocuiti memoria de la
alti furnizori cu memorie de la HP.

4. Inlocviti placa de sistem.

Placa video nu este

pozifionatd corect sau
este defectd sau placa
de sistem este defectd.

LED-ul de alimentare clipeste
de sase ori cu culoare rosie,
o data pe secundd, dupa
care urmeazd o pauzd

de doud secunde, iar
computerul emite sase
semnale sonore.

Pentru sistemele cu o placa grafica:
1. Repozifionati placa grafica.
Porniti sistemul.
2. Inlocuiti placa grafica.
3. Inlocuiti placa de sistem.

Pentru sistemele cu placa grafica
integratd, inlocuiti placa de sistem.

1. Verificati fiecare placa optionala
prin scoaterea placilor pe rénd
(daca exista mai multe placi), apoi
porniti sistemul pentru a vedea
daca dispare defecfiunea.

. Daca afi identificat placa
defectd, scoateti-o si inlocuiti-o.

3. Inlocuiti placa de sistem.

LED-ul de alimentare clipeste Placa opfionala defects.
de zece ori cu culoare rosie,

o data pe secundd, dupa

care urmeazd o pauzd

de doud secunde, iar

computerul emite zece 2

semnale sonore.
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Rezolvarea problemelor de retea

O parte dintre cele mai intalnite cauze si solutii pentru probleme
de retea sunt listate Tn tabelul urmdtor. Aceste instructiuni nu trateaza
procesul de depanare a cablurilor retelei.

Rezolvarea problemelor de retea

Problema

Cavza

Solutie

Caracteristica
Wake-On-LAN nu

functioneaza.

Caracteristica
Wake-On-LAN nu este
activatd. 1

2.

Activati caracteristica
Woake-On-LAN.

. Selectati Start > Control

Panel (Panou de control).
Facefi dublu clic pe Network
Connections (Conexiuni

in refea).

. Faceti dublu clic pe Local Area

Connection (Conexiuni locale).

. Faceti clic pe Properties

(Proprietati).

. Facei clic pe Configure

(Configurare).

. Faceti clic pe fila Power

Management (Gestionare
energie), apoi selectafi caseta
Allow this device to bring
the computer out of
standby (Este permis ca acest
dispozitiv s& scoatd computerul
din starea de oprire temporara).

Driverul de retea nu
detecteazé& controlerul
de refea.

Controlerul de refea este 1.

dezactivat.

Executati programul Computer
Setup si activati controlerul
de refea.

. Activati controlerul de refea din

sistemul de operare prin Device
Manager (Manager dispozitive).

Driver de retea incorect.

Pentru driverul corect consultati

documentatia controlerului de retea
sau obtineti cel mai recent driver de
la situl Web al producatorului.
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Rezolvarea problemelor de retea (Continuare)

Problema

Cauza

Solutie

Indicatorul luminos de
legaturd pentru starea
refelei nu clipeste deloc.

N Indicatorul luminos
pentru starea refelei
ar trebui sd clipeasca
atunci cand exista
activitate in refea.

Nu s-a detectat nici
o refea activd.

Pentru o conexiune corectd, verificati
cablurile si echipamentul de refea.

Controlerul de retea nu este
configurat corect.

Verificati starea dispozitivului din
Windows, prin Device Manager
pentru incarcarea driverului si prin
Network Connections pentru starea
legaturii.

Controlerul de refea este
dezactivat.

1. Executati programul Computer
Setup si activati controlerul
de refea.

2. Activati controlerul de retea din
sistemul de operare prin Device
Manager (Manager dispozitive).

Driverul de retea nu este
incarcat corect.

Instalati din nou driverele de retea.
Consultati Ghid de comunicatii

in refea si Internet de pe
Documentation CD.

Sistemul nu sesizeaza
automat refeaua.

Dezactivati capacitdfile de sesizare
automatd si fortati sistemul s& intre
in modul de operare corect.
Consultati Ghid de comunicatii

in refea si Internet de pe
Documentation CD.

Sistemul de diagnosticare
raporteazd o defectiune.

Cablul nu este conectat ferm.

Verificati dacé este atasat ferm
cablul la conectorul de refea si daca
celalalt capat al cablului este atasat
ferm la dispozitivul corespunzator.

Cablul este atasat la un
conector gresit.

Verificati dac& este atasat cablul la
conectorul corect.

Exista o problemé cu cablul
sau cu un dispozitiv de la
celalalt capat al cablului.

Verificati daca dispozitivul de la
celalalt capat al cablului sau cablul
functioneazé corect.

IRQ-ul controlerului de refea
este partajat cu o placa
de extensie.

Sub meniul Advanced din
programul Computer Setup, modificai
setarile de resurse pentru placa.
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Rezolvarea problemelor de retea (Continuare)

Problema

Cauza

Solutie

Sistemul de diagnosticare
raporteazd o defeciune.
(continuare)

Controlerul de refea
este defect.

Contactati un furnizor de servicii
autorizat.

Diagnosticarea s-a finalizat
corect, dar computerul nu
comunicd cu refeaua.

Nu sunt incarcate driverele
de refea sau parametrii
driverelor nu corespund cu
configurafia curentd.

Verificati dac& sunt incdrcate
driverele de refea si daca parametrii
driverelor corespund cu configuratia
controlerului de retea.

Verificati daca software-ul client
si protocolul instalate sunt cele corecte.

Controlerul de refea nu
este configurat pentru acest
computer.

Selectati pictograma Network
din Control Panel
si configurati controlerul de refea.

Controlerul de refea nu
mai functioneaza dupé
adaugarea unei placi de
extensie la computer.

IRQ-ul controlerului de refea
este partajat cu o placa
de extensie.

Sub meniul Advanced din
programul Computer Setup, modificati
setdrile de resurse pentru placa.

Controlerul de refea
solicita drivere.

Verificati dacé& driverele nu au fost
sterse accidental atunci cand s-au
instalat driverele placii de extensie.

Placa de extensie instalat&
este o placa de refea (NIC)
si intra in conflict cu

controlerul NIC incorporat.

Sub meniul Advanced din programul
Computer Setup, modificati setérile
de resurse pentru placa.

Controlerul de refea nu
mai functioneazd, fara nici
un motiv aparent.

Fisierele care contin driverele
de refea sunt corupte.

Reinstalati driverele de refeq,
utilizand CD-ul Restore Plus!.

Cablul nu este conectat ferm.

Verificati dacé este atasat ferm
cablul la conectorul de refea si daca
celalalt capat al cablului este atasat
ferm la dispozitivul corespunzator.

Controlerul de refea
este defect.

Contactati un furnizor de servicii
autorizat.
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Rezolvarea problemelor de retea (Continuare)

Problema

Cauza

Solutie

Noua placa de refea nu
incarca sistemul.

Noua placa de refea poate

fi defectd sau nu se

incadreazd in specificatiile

standardului industrial.

Instalati un NIC functional, la
standard industrial, sau modificati
secvenfa de incércare pentru
a incérca sistemul de la altd sursa.

Conectarea la serverul
refelei nu reuseste, atunci
cand se incearcé
instalarea sistemului de
la distanta.

Controlerul de refea nu este

configurat corect.

Verificati conectivitatea retelei, daca
este prezent un server DHCP si dacs
serverul pentru instalarea sistemului
de la distantd contine drivere NIC
pentru controlerul dvs. NIC.

Programul utilitar de
configurare a sistemului
raporteaz& o memorie
EEPROM neprogramata.

Memorie EEPROM
neprogramata.

Contactati un furnizor de servicii
autorizat.
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Rezolvarea problemelor legate de memorie

Dacd intampinati probleme legate de memorie, unele dintre cele mai
intilnite cauze si solutii sunt listate 1n tabelul de mai jos.

ATENTIE: Pentru sistemele care accept& memorii ECC, HP nu acceptd
amestecul de memorii ECC cu memorii non-ECC. In caz contrar,
computerul nu va incdrca sistemul de operare.

Rezolvarea problemelor legate de memorie

Problema

Cavuza

Solutie

Sistemul nu se incarcd sau

nu functioneazd corect dup&

instalarea de module de
memorie suplimentare.

Modulul de memorie nu
este de tipul sau de
gradul de vitez& corecte
pentru sistem sau noul
modul de memorie nu
este pozitionat corect.

Inlocuiti modulul cu un dispozitiv
cu un standard industrial corect
pentru computer.

La anumite modele, modulele de
memorie ECC si non-ECC nu pot
fi amestecate.

Eroare de depasire
a memoriei.

Este posibil sa& nu fie
sefatd corect configuratia
memoriei.

Utilizati Device Manager
si verificati configuratia memoriei.

Nu existd memorie
suficienta pentru
a executa aplicatia.

Verificati documentatia aplicatiei
pentru a determina necesarul
de memorie.

Contorul de memorie de la
testarea POST este gresit.

Este posibil ca modulele
de memorie sé nu fie
instalate corect.

Verificati dacé modulele de memorie
sunt instalate corect si dacd s-au
utilizat module corespunzétoare.

Este posibil ca memoria
sistemului sd fie utilizats
de catre placa grafica
integratd.

Nu este necesard nici o acfiune.

Memorie insuficients
in timpul functiondrii.

Sunt instalate prea multe
programe TSR (Terminate
and Stay Resident) -
programe care raman
rezidente in memorie
dupa ce se executd.

Stergeti toate programele TSR care
nu sunt necesare.
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Rezolvarea problemelor legate de memorie (Continuare)

Problema Cauza Solutie

Memorie insuficientd Nu existé memorie Verificati necesarul de memorie

in timpul functionarii. suficientd pentru aplicatie. pentru aplicatie si addugati memorie
(continuare) la computer.

LED-ul de alimentare clipeste  Memoria este instalatd 1. Repozitionati modulele DIMM.
de cinci ori cu culoare rosie, incorect sau este defects. Porniti sistemul.

o datd pe secundd, dupa 2. Pentru a identifica modulul defect,

care urmeazd o pauzd
de doud secunde, iar
computerul emite cinci
semnale sonore.

inlocuiti pe rand modulele DIMM.

3. Inlocuiti memoria de la alfi
furnizori cu memorie de la HP.

4. Tnlocuiti placa de sistem.

Rezolvarea problemelor legate de procesor

Dacd intdmpinati probleme legate de procesor, cele mai intalnite
cauze si solutii sunt listate in tabelul de mai jos.

Rezolvarea problemelor legate de procesor

Problema Cauza Solutie
Sistemul functioneaza Procesorul este incins. 1. Avefi grija sa nu fie blocat
cu performante reduse. curentul de aer spre computer.

2. Verificati daca ventilatoarele
sunt conectate si functioneazé
corect (unele ventilatoare
functioneaz& numai cand
este necesar).

3. Verificati dacd radiatorul
procesorului este instalat corect.

LED-ul rosu de alimentare Procesorul nu este 1. Verificati dac& procesorul
clipeste cu culoare rosie de  pozifionat corect sau nu este prezent.
trei ori, o datd pe secundd,  este instalat. 2. Repozitionafi procesorul.

dupd care urmeaza
o pauzd de doud secunde.
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Rezolvarea problemelor legate
de CD-ROM sau DVD

Dacd intampinati probleme legate de CD-ROM sau DVD, consultati
cele mai intalnite cauze si solutii listate n tabelul urmétor sau
documentatia livratd impreund cu dispozitivul optional.

Rezolvarea problemelor legate de CD-ROM sau DVD

Problema

Cavza

Solutie

Sistemul nu se incarcd de

pe CD-ROM sau DVD.

In programul Computer
Setup este dezactivata
opfiunea Removable
Media Boot (Incarcare
de pe suport amovibil).

Executati programul utilitar Computer
Setup si activati incarcarea de pe
suporturi amovibile din Storage >
Storage Options (Stocare —
Optiuni stocare). Verificati daca
optiunea IDE CD-ROM este activatd
in Storage > Boot Order
(Stocare — Ordine de incdrcare).

Optiunea Network
Server Mode (Mod server
de refea) este activata

in programul

Computer Setup.

Executai programul Computer Setup
si dezactivali opfiunea Network
Server Mode din Security >
Password Options (Securitate —
Optiuni parola).

In unitate este un CD
care nu este incdrcabil.

Incercati s& introduceti un CD
ncdrcabil in unitate.

Ordinea de incdrcare nu
este corecta.

Executati programul utilitar
Computer Setup si modificati
secvenfa de incdrcare din
Storage > Boot Order.

Dispozitivele CD-ROM sau
DVD nu sunt detectate sau
driverul nu este incdrcat.

Unitatea nu este
conectatd corect sau nu
este configuratd corect.

Consultati documentatia livratd
impreund cu dispozitivul opfional.

Filmul din unitatea DVD
nu poate fi redat.

Este posibil ca filmul
s& aiba sefari regionale
pentru o altd tara.

Consultati documentatia livraté
impreund cu unitatea DVD.

Software-ul decodor
nu este instalat.

Instalati software-ul decodor.

Suport defect.

Inlocuiti suportul.
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Rezolvarea problemelor legate de CD-ROM sau DVD (Continuare)

Problema

Cauza

Solutie

Filmul din unitatea DVD
nu poate fi redat.
(continuare)

Filmul este evaluat
ca blocat de
controlul parental.

Utilizati software-ul DVD-ului pentru
a elimina blocajul parental.

Suportul este
instalat invers.

Instalati din nou suportul.

Discul compact nu poate

fi evacuat (tava de incarcare

a unitatii).

Discul nu este pozitionat
corect in unitate.

Opriti computerul, introduceti o bara
subfire de metal in gaura pentru
evacuare de urgen}d si apdsati ferm.
Trageli usor afard tava din unitate
pand la extinderea completd, apoi
scoateti discul.

Unitatea CD-ROM, CD-RW,

DVD-ROM sau DVD-R/RW
nu citeste un disc sau
dureazé prea mult pana
cand porneste.

Suportul a fost
introdus invers.

Introduceti din nou suportul,
cu eticheta in sus.

Pornirea unitafii
DVD-ROM dureazad mai
mult, deoarece aceasta
trebuie s& determine tipul
suportului de redat,
precum audio sau video.

Asteptati cel putin 30 de secunde
pentru ca unitatea DVD-ROM

s& determine tipul suportului de redat.
Daca discul tot nu porneste, citii
celelalte solutii listate pentru acest
subiect.

Discul CD sau DVD

este murdar.

Curatati CD-ul sau DVD-ul cu un
pachet de curdtare, disponibil
la majoritatea magazinelor

de computere.

Windows nu detecteazd
unitatea CD-ROM sau
DVD-ROM.

1. Utilizati Device Manager pentru
a elimina sau dezinstala unitatea
respectivd.

2. Reporniti computerul
si lasati sistemul Windows sé&
detecteze unitatea CD sau DVD.

inregistrarea CD-urilor audio
este dificila sau imposibila.

Tip de suport gresit sau
de slaba calitate.

1. Tncerccli sa utilizati o vitez& mai
micd la inregistrare.

2. Verificali daca utilizati tipul corect
de suport pentru aceastd unitate.

3. Incercati o altad marca de suport.
Calitatea difera de la
un producdtor la altul.
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Depanarea féra diagnosticare

Rezolvarea problemelor legate de Drive Key

Daci intampinati probleme legate de Drive Key, cele mai intalnite
cauze si solutii sunt listate in tabelul de mai jos.

Rezolvarea problemelor legate de Drive Key

Solutie

Problema Cauza

Unitatea Drive Key nu este  Litera de unitate care

vazuta ca o literd de urmeazda dupd ultima

unitate in Windows XP. unitate fizicd nu este
disponibila.

Modificati litera de unitate implicita
pentru Drive Key in Windows XP.

Dupd realizarea unui Drive  Unitatea Drive Key este
Key incarcabil, computerul  incarcabila.
se incarca din DOS.

Instalati unitatea Drive Key numai
dupd ce se incarcd sistemul
de operare.

Rezolvarea problemelor de acces la Internet

Dacd intampinati probleme cu accesul la Internet, consultati
furnizorul de servicii Internet (ISP) sau cauzele si solutiile cele
mai Intalnite, listate in tabelul urmator.

Rezolvarea problemelor de acces la Internet

Problema Cauza Solutie
Conectarea la Internet Contul furnizorului de Verificati setérile Internet sau
nu reuseste. servicii Infernet (ISP) nu  contactati ISP-ul pentru asistenfd.

este configurat corect.

Modemul nu este
configurat corect.

Reconectati modemul. Verificati
corectitudinea conexiunilor, utilizand
documentatia de configurare rapida.

Browserul Web nu este
configurat corect.

Verificati dac& browserul Web este
instalat si configurat pentru
a functiona cu ISP-ul respectiv.

Modemul de cablu/DSL

nu este montat.

Montati modemul de cablu/DSL.
Ar trebui sa vedeti un indicator LED

,power” (pornit) pe partea frontald
a modemului de cablu/DSL.

Ghid de depanare www. hp.com
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Depanarea férg diagnosticare

Rezolvarea problemelor de acces la Internet (Continuare)

Problema Cauza Solutie

Conectarea la Internet Serviciul prin cablu/DSL  Incercati s& va conectati la Internet

nu reuseste. (continuare) nu este disponibil sau mai tarziu sau contactati ISP-ul. (Daca
a fost intrerupt din cauze  serviciul prin cablu/DSL este conectat,
meteorologice. indicatorul LED ,,cable” (cablu)

de pe partea frontald a modemului

de cablu/DSL va fi aprins.)

Cablul UTP CAT5 nu Conectati cablul UTP CATS5 intre

este conectat. modemul de cablu si conectorii RJ-45
ai computerelor. (Dacd conexiunea
este bund, indicatorul LED ,PC” de

pe partea frontald a modemului
de cablu/DSL va fi aprins.)

Adresa IP nu este Contactati ISP pentru adresa
configuratd corect. IP corecta.
Modulele cookie sunt In Windows XP:

corupte. (Un modul
~cookie” este un grup
mic de informatii pe care
un server Web le poate
stoca temporar impreund

1. Selectati Start > Control
Panel (Panou de control).

2. Faceti dublu clic pe Internet
Options (Optiuni Internet).

cu browserul Web. 3. In fila General, facefi clic
Acestea sunt utile pentru pe butonul Delete Cookies
ca browserul sa poatad (Stergere module cookie).

memora unele informatii
specifice pe care serverul
Web sa poata sa le
preia ulterior.)

Programele Internet nu se pot  Inainte ca anumite Conectati-va la ISP

lansa automat. programe s& porneascd, si lansafi programul dorit.
trebuie sd va conectati
la ISP.
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Depanarea féra diagnosticare

Rezolvarea problemelor de acces la Internet (Continuare)

Problema

Cauza

Solutie

Descdrcarea siturilor Web din - Modemul nu este

Internet dureazé prea mult.

configurat corect.

Verificafi daca viteza si port-ul COM
pentru modem sunt selectate corect.

in Windows XP:

1.

Selectati Start > Control
Panel (Panou de control).

. Faceti dublu clic pe System

(Sistem).

. Faceti clic pe fila Hardware.

. In zona Device Manager

(Manager dispozitive), faceti clic
pe butonul Device Manager.

. Faceti dublu clic pe Ports

(COM & LPT) (Port-uri).

. Faceti clic cu butonul din dreapta

al mausului pe port-ul COM
utilizat de modem, apoi
faceti clic pe Properties
(Proprietati).

. Sub Device status (Stare

dispozitiv), verificati daca
modemul functioneazé& corect.

. Sub Device usage (Utilizare

dispozitiv), verificali daca
modemul este activat.

. Daca existd in continuare

probleme, faceti clic pe butonul
Troubleshoot (Depanare)

si urmati instructiunile de

pe ecran.

Ghid de depanare
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Depanarea férg diagnosticare

Rezolvarea problemelor legate de software

Majoritatea problemelor software survin ca rezultat al

urmatoarelor cauze:

B Aplicatia nu a fost instalatd sau configurata corect.

Nu existd memorie suficientd pentru a executa aplicatia.

|
B Existd un conflict intre aplicatii.
|

Verificati daca au fost instalate toate driverele necesare pentru

dispozitive.

B Daci ati instalat un alt sistem de operare decét cel instalat din
fabrica, verificati daca acesta este acceptat de sistem.

Daci este disponibil, executati programul utilitar Configuration
Record (Inregistrare configuratie) pentru a determina daci s-au ficut
modificari ale software-ului care au generat problema. Pentru mai
multe informatii, consultati sectiunea ,,Configuration Record* din

acest ghid.

Daci aveti probleme legate de software, consultati solutiile aplicabile

listate 1n tabelul urmator.

Rezolvarea problemelor legate de software

Problema Cauza

Solutie

Computerul nu mai A survenit o eroare
funcfioneaza si nu a aparut  la testele POST.
nici un ecran cu sigla HP.

Observati semnalele sonore

si LED-urile de pe panoul frontal

al computerului. Pentru a defermina
cauzele posibile, consultafi

Anexa A, ,Mesaje de eroare ale

testelor POST”.

Consultati termenii si conditiile din
Restore Kit (Pachet de restaurare)

sau din Worldwide Limited Warranty
(Garantie limitata pe plan
international).

Computerul nu mai Este posibil ca fisierele
funcfioneaza dupd ce de sistem sa fie
a aparut ecranul cu sigla HP. deteriorate.

Utilizati discheta de recuperare pentru
a scana unitatea de disc de erori.
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Depanarea féra diagnosticare

Rezolvarea problemelor legate de software (Continuare)

Problema Cauza Solutie
Se afiseazd mesajul ,lllegal  Software-ul pe care il Verificati daca software-ul este
Operation has Occurred”  utilizai nu este certificat  certificat de Microsoft pentru aceastd
(A survenit o operatiune de Microsoft pentru versiune de Windows (pentru aceastd
ilegala). aceastd versiune informatie, consultati ambalajul

de Windows. programului).

Fisierele de configurare  Daca este posibil, salvati toate
sunt corupte. datele, inchideti toate programele
si reporniti computerul.

Contactarea asistentei pentru clienti

Pentru ajutor si asistentd, contactati un distribuitor autorizat. Pentru
a gdsi un distribuitor apropiat de zona 1n care va aflati, vizitati
www.hp.com.

Daci duceti computerul la un distribuitor sau furnizor de servicii
neautorizat pentru service, nu uitati sa i furnizati parolele de setare
si de pornire, dacd sunt stabilite.

Pentru asistentd tehnica, apelati numarul corespunzétor de telefon
dintre cele specificate 1n certificatul de garantie sau n ghidul Support
Telephone Numbers (Numere de telefon ale reprezentantelor) de pe
Documentation CD.

Ghid de depanare

www. hp.com 2-49


http://www.hp.com

A

Mesaje de eroare ale testelor POST

Aceastd anexa listeazd codurile de eroare, mesajele de eroare si
diferitele secvente sonore si luminoase care se pot intdlni in timpul
testelor POST (testare automatd la pornire) sau in timpul repornirii
computerului, sursele probabile ale problemelor si pasii care se pot
urma pentru rezolvarea conditiilor de eroare.

POST Message Disabled (Mesaj POST dezactivat) elimind majoritatea
mesajelor de sistem din timpul testelor POST, precum contorul

de memorie si mesajele text care nu semnaleazi erori. Dacd survine

o eroare POST, pe ecran se va afisa mesajul de eroare. Pentru a comuta
manual pe modul Post Messages Enabled 1n timpul testelor POST,
apdsati orice tasta (cu exceptia tastelor F10 sau F12). Modul implicit
este POST Message Disabled.

Viteza la care computerul incarcd sistemul de operare si limita pand
la care este testat sunt determinate prin selectia modului de testare POST.

Quick Boot (Incircare rapidi) este un proces rapid de pornire care

nu executd toate testele de la nivelul sistemului, cum ar fi testul de
memorie. Full Boot (Incircare completii) executi toate testele de sistem
bazate pe memoria ROM si dureazd mai mult pana la finalizare.

De asemenea, Full Boot poate fi activati sd se execute cu o periodicitate
de 1 pana la 30 de zile, pe baza unei programari regulate. Pentru

a stabili programarea, reconfigurati computerul in modul Full Boot
Every x Days (Incircare completi la fiecare X zile), utilizand
programul Computer Setup.

Pentru mai multe informatii despre setarea computerului, consultati
Ghidul programului utilitar Computer Setup (F10) de pe
Documentation CD.

Ghid de depanare
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Mesaje de eroare ale testelor POST

Coduri numerice POST si mesaje text

SN

In aceasti sectiune sunt tratate acele erori POST care au asociate
coduri numerice. De asemenea, n sectiune sunt incluse si unele
mesaje text care se pot intilni In timpul testelor POST.

Dupa afisarea pe ecran a unui mesaj text POST, computerul va emite

un semnal sonor.

Coduri numerice si mesaje text

Cod/Mesaj

Cauzéa probabila

Actiune recomandata

101-Option ROM
Checksum Error
(Eroare de suma

de control la memoria
ROM optionala)

Suma de control pentru
memoria ROM

a sistemului sau pentru
memoria ROM opfionald
a placii de extensie.

1.
2.

Verificati memoria ROM corectd.

Daca este necesar, curdtati
memoria ROM.

. Daca s-a addugat recent o placa

de extensie, scoatefi-o pentru a vedea
daca problema persista.

. Goliti memoria CMOS. (Consultati

Anexa B, ,Securitatea prin parole
si reinitializarea memoriei CMOS")

. Daca mesaijul dispare, este posibil sa

existe o problemd la placa de extensie.

. Inlocuiti placa de sistem.

102-System Board
Failure (Defectiune
la placa de sistem)

Accesul DMA sau

contoarele de timp.

1. Goliti memoria CMOS. (Consultati

Anexa B, ,Securitatea prin parole
si reinitializarea memoriei CMOS")

. Scoatefi placile de extensie.

. Inlocuiti placa de sistem.

103-System Board

Failure

Accesul DMA sau

contoarele de timp.

1. Goliti memoria CMOS. (Consultati

Anexa B, ,Securitatea prin parole
si reinitializarea memoriei CMOS")

. Scoateti placile de extensie.

. Inlocuiti placa de sistem.
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Mesaje de eroare ale testelor POST

Coduri numerice si mesaje text (Continuare)

Cod/Mesaij Cauza probabila Actiune recomandaté
110-Out of Memory  Placa de extensie PCI 1. Dacé s-a addugat recent o placa de
Space for Option addugatd recent contine extensie PCl, scoatefi-o pentru a vedea

ROMs (Spatiu de o memorie ROM optionala
memorie insuficient prea mare pentru a se
pentru memoriile descarca in timpul

ROM optionale) testelor POST.

daca problema persista.

2. Pentru a se elibera mai multéd memorie
pentru o memorie ROM opfional&
a unei placi de extensie, in programul
Computer Setup, setafi Advanced >
Device Options > NIC PXE
Option ROM Download (Avansat -
Optiuni dispozitive — Descéarcare
memorie ROM optionala NIC PXE)
pe DISABLE (Dezactivat), pentru
a impiedica descarcarea memoriei
ROM optionale PXE pentru controlerul
NIC in timpul testelor POST. Memoria
ROM optionala PXE interna este
utilizatd pentru incarcarea sistemului
de pe controlerul NIC pe un server PXE.

3. Activati setarea ACPI/USB Buffers @
Top of Memory din programul
Computer Setup.

150-SafePost O placa de extensie PCl
Active (Testare nu raspunde.
SafePost activa)

1. Reporniti computerul.
2. Dezactivati testarea SafePost.

3. Dacd placa de extensie nu raspunde,
inlocuiti placa.

162-System Options  Configuratie incorectd.

Not Set (Optiunile de  ggte posibil s& fie

sistem nu sunt setate)  ecesard inlocuirea
bateriei RTC (real-time
clock - ceas in timp real).

Executati programul Computer Setup

si verificati configuratia in Advanced >
Onboard Devices (Avansat - Dispozitive
montate pe placa de sistem).

Resetati data si ora din Control Panel.
Daca problema persistd, inlocuiti bateria
RTC. Pentru instructiuni despre instalarea
unei baterii noi, consultati Ghid de referinfa
hardware de pe Documentation CD sau
contactati un distribuitor autorizat pentru

a inlocui bateria RTC.
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Mesaje de eroare ale testelor POST

Coduri numerice si mesaje text (Continuare)

Cod/Mesaij Cauza probabila Actiune recomandaté

163-Time & Date Not  Oré& sau daté nevalidé in - Reinitializati data si ora din Control

Set (Ora sidata nu memoria de configurare.  Panel (Panou de control) (se poate utiliza

sunt sefate) Este posibil s& fie si programul Computer Setup). Daca
necesard inlocuirea problema persistd, inlocuiti bateria RTC.

bateriei RTC (real-time Pentru instructiuni despre instalarea unei
baterii noi, consultati Ghid de referinta
hardware de pe Documentation CD sau
contactafi un distribuitor autorizat pentru
a inlocui bateria RTC.

clock - ceas in timp real).

Este posibil ca jumperul  Verificati daca jumperul CMOS este
CMOS sa nu fie amplasat corect.
instalat corect.

164-Memory Size Dimensiunea memoriei s-a Apdsati tasta F1 pentru a salva

Error (Eroare de modificat de la ultima modificarile memoriei.

dimensiune incarcare a sistemului

a memoriei) (s-a addugat sau
s-a sCos memorie).
Configuratia memoriei 1. Executati programul Computer Setup
este incorectd. sau programele utilitare

pentru Windows.
2. Verificati dacé modulele de memorie
sunt instalate corect.

3. Dacd a fost addugatd memorie de
la alti furnizori, efectuati o testare
utilizéind exclusiv memorie HP.

4. Verificati daca tipul modulului
de memorie este corect.
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Mesaje de eroare ale testelor POST

Coduri numerice si mesaje text (Continuare)

Cod/Mesaij

Cauza probabila

Actiune recomandaté

201-Memory Error
(Eroare de memorie)

Defectiune
a memoriei RAM.

1

2.

3.

4.

. Executati programul Computer Setup sau

programele utilitare pentru Windows.
Verificati dacé modulele de memorie
sunt instalate corect.

Verificati dacd tipul modulului

de memorie este corect.

Scoateti si inlocuiti modulele de memorie
pe rénd, pentru a izola modulul defect.

5. Inlocuiti modulele de memorie defecte.

6.

Daca eroarea persistd dupd inlocuirea
modulelor de memorie, inlocuiti placa
de sistem.

202-Memory Type
Mismatch (Tipuri
incompatibile

de memorie)

Modulele de memorie
nu sunt compatibile unul
cu altul.

Inlocuiti modulele de memorie cu seturi
de module compatibile.

213-Incompatible
Memory Module

in Memory Socket(s)
X, X, ... (Modul de
memorie incompatibil
n soclul/soclurile de
memorie X, X,...)

Unui modul de memorie
din soclul de memorie
indicat in mesajul de
eroare ii lipsesc informatii
critice SPD sau este
incompatibil cu setul de
circuite integrate.

2.

. Verificati dacd tipul modulului de

memorie este corect.
Incercati alt soclu de memorie.

3. Tnlocuiti modulul DIMM cu un modul

care este in conformitate cu
standardul SPD.

214-DIMM
Configuration
Warning (Avertisment

de configuratie
a modulelor DIMM)

A survenit o anumitd
eroare la un modul
de memorie instalat
n soclul indicat.

. Verificati daca tipul modulului de

memorie este corect.

. Incercati alt soclu de memorie.
. Daca problema persista,

tnlocuiti modulul de memorie.

219-ECC Memory
Module Detected ECC
Modules not supported
on this Platform
(Modulul de memorie
ECC a defectat module
ECC neacceptate pe
aceastd platforma)

Modulele de memorie
adaugate recent acceptd
corectia erorilor
memoriei ECC.

. Daca s-a adaugat recent memorie

suplimentard, scoatefi-o pentru a vedea
daca problema persista.

. Consultati documentatia produsului

pentru informatii despre asistenfa
pentru memorie.
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Mesaje de eroare ale testelor POST

Coduri numerice si mesaje text (Continuare)

Cod/Mesaij Cauza probabila Actiune recomandaté
301-Keyboard Error  Defecfiune a tastaturii. 1. Reconectafi tastatura cénd computerul
(Eroare la tastatura) este oprit.

2. Verificafi dacd la conector exista pini
indoiti sau daca lipsesc pini.

3. Verificati dacd nu este apdsata nici
o tastd.

4. Inlocuiti tastatura.

303-Keyboard Controlerul tastaturii de pe 1. Reconectati tastatura céind computerul
Controller Error placa de intrare/iesire. este oprit.

(Eroare la controlerul 2. Inlocuiti placa de sistem.

tastaturii)

304-Keyboard or Defectiune a tastaturii. 1. Reconectafi tastatura cénd computerul
System Unit Error este oprit.

(Eroare la tastatura 2. Verificati dacd nu este apdsatd nici
sau la unitatea de o fastd.

sistem) 3. Inlocuiti fastatura.

4. Inlocviti placa de sistem.

404-Parallel Port Ambele port-uri, extern 1. Scoatefi toate pléacile de extensie cu
Address Conflict si intern, sunt asociate port paralel.

Detected (S-a detectat port-ului paralel X. 2. Goliti memoria CMOS. (Consultafi
un conf!lcf la adresa Anexa B, ,Securitatea prin parole
port-ului paralel) si reinitializarea memoriei CMOS")

3. Reconfigurati resursele placii si/sau
executali programul Computer Setup.

410-Audio Interrupt  Adresa IRQ este in conflict Intrati in programul Computer Setup

Conflict (Conflictla  cu alt dispozitiv. si resetati adresa IRQ din Advanced >

intreruperea audio) Onboard Devices (Avansat — Dispozitive
montate pe placa de sistem).

411-Network Interface  Adresa IRQ este in conflict Intrafi in programul Computer Setup

Card Interrupt Conflict  cu alt dispozitiv. si resetafi adresa IRQ din Advanced >
(Conflict la intreruperile Onboard Devices (Avansat — Dispozitive
placii de interfajé montate pe placa de sistem).

cu refeaua)
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Mesaje de eroare ale testelor POST

Coduri numerice si mesaje text (Continuare)

Cod/Mesaij Cauza probabila Actiune recomandaté
501-Display Adapter  Controlerul de 1. Repozitionati placa grafica
Failure (Defectiune afisare grafica. (daca este cazul).

la placa graficd) 2. Goliti memoria CMOS. (Consultati

Anexa B, ,Securitatea prin parole
si reinitializarea memoriei CMOS*)

3. Verificati dacd monitorul este conectat
si daca este pornit.

4. Inlocviti placa grafica
(daca este posibil).

510-Splash Screen  Imaginea ecranului initial  Pentru a restaura imaginea, instalati cea
Image Corrupted are erori. mai recentd versiune de ROMPag.
(Imaginea ecranului

initial este corupta)

511-CPU, CPUA, or  Ventilatorul unitatii 1. Repozitionati ventilatorul unitatii CPU.
CPUB Fan not Defected  centrale de prelucrare 2. Repozitionafi cablul ventilatorului.
(Nu s-a detectat un (CPU) nu este conectat sau inlocut | | unitati

ventilator de CPU, nu functioneaz& corect. - Inlocuifi ventilatorul unitafii CPU.
CPUA sau CPUB)

512-Chassis, Rear Un ventilator al sasiului, 1. Repozitionati ventilatorul sasiului, al
Chassis, or Front al sasiului dorsal sau al sasiului dorsal sau al sasiului frontal.
Chassis Fan not sasiului frontal nu este 2. Repozitionafi cablul ventilatorului.
Detected (Nu s-a conectat sau nu

3. Inlocuiti ventilatorul sasiului, al sasiului

detectat un ventilator  functioneazd corect. Rte
dorsal sau al sasiului frontal.

al sasiului, al sasiului
dorsal sau al
sasiului frontal)

514-CPU or Chassis  Ventilatorul unitafii centrale 1. Repozifionati ventilatorul de CPU sau

Fan not Detected (Nu  de prelucrare (CPU) sau ventilatorul sasiului.

s-a detectat ventilatorul  ventilatorul sasiului nu este

de CPU sau al sasiului) conectat sau nu
functioneazé corect.

N

. Repozitionati cablul ventilatorului.

3. Inlocuiti ventilatorul de CPU sau
ventilatorul sasiului.

Ghid de depanare www. hp.com A-7



Mesaje de eroare ale testelor POST

Coduri numerice si mesaje text (Continuare)

Cod/Mesaij

Cauza probabila Actiune recomandaté

601-Diskette
Controller Error
(Eroare la controlerul
unitatii de dischetd)

Ansamblul de circuite al 1
unitatii de dischet& sau 9
al controlerului unitdtii de
dischet& este incorect.

. Executati programul Computer Setup.
. Verificati si/sau inlocuiti cablurile.

3.

Goliti memoria CMOS. (Consultati
Anexa B, ,Securitatea prin parole
si reinitializarea memoriei CMOS*)

4. Inlocuiti unitatea de discheta.
5. Tnlocuiti placa de sistem.
605-Diskette Drive Incompatibilitate a tipului 1. Executati programul Computer Setup.
TYF?e Ilfrror (Er°9re de unitate. 2. Deconectati toate celelalte dispozitive
a fipului d? unitate controler de dischetd (unitati de banda).
de dischetd) - i ,
3. Goliti memoria CMOS. (Consultati
Anexa B, ,Securitatea prin parole
si reinitializarea memoriei CMOS")
610-External Storage  Unitatea externa de Reinstalati unitatea de banda sau

Device Failure
(Defectiune la
dispozitivul de
stocare extern)

banda nu este conectatd.  apasati tasta F1 si permiteti sistemului
s& se reconfigureze fara unitate.

611-Primary Floppy
Port Address
Assignment Conflict
(Conflict de atribuire
a adresei port-ului
unitatii primare de
dischetd)

Eroare de configuratie. Executati programul Computer Setup
si verificati configuratia in Advanced >
Onboard Devices (Avansat — Dispozitive
montate pe placa de sistem).

660-Display cache is
detected unreliable
(S-a detectat c&
memoria cache de
afisare nu este fiabild)

Memoria cache de afisare  Dacé se observa o degradare cat de mica
a controlerului grafic a gradficii, inlocuiti placa de sistem.

integrat nu funcfioneaza
corect si va fi dezactivatd.
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Mesaje de eroare ale testelor POST

Coduri numerice si mesaje text (Continuare)

Cod/Mesaij

Cauza probabila

Actiune recomandaté

912-Computer Cover
Has Been Removed
Since Last System
Startup (Capacul
computerului a fost
scos dupd ultima
pornire a sistemului)

Capacul computerului
a fost scos dupd ultima
pornire a sistemului.

Nu este necesard nici o actiune.

914-Hood Lock Coil
is not Connected
(Bobina de blocare
a capacului nu

este conectatd)

Mecanismul Smart Cover
Lock nu este prezent sau
nu este conectat.

1. Reconectati sau inlocuiti mecanismul
de blocare a capacului.

2. Repozifionati sau inlocuiti cablul
mecanismului de blocare a capacului.

916-Power Button Not
Connected (Butonul
de alimentare nu

este conectat)

Firele butonului de
alimentare s-au desprins
sau nu sunt pozifionate
corect la placa de baza.

Reconectati sau inlocuiti firele butonului
de alimentare.

917-Front Audio Not
Connected (Sistemul
audio frontal nu

este conectat)

Firele sistemului audio s-au
desprins sau nu sunt
pozifionate corect la placa
de baza.

Reconectati sau inlocuiti firele sistemului
audio frontal.

918-Front USB Not
Connected
(Magistrala USB
frontala nu

este conectatd)

Firele magistralei USB
frontale s-au desprins sau
nu sunt pozitionate corect
la placa de baza.

Reconectati sau inlocuiti firele magistralei
USB frontale.

919-Multi-Bay Riser
not Connected
(Ridicatorul Multi-Bay
nu este conectat)

Placa ridicatorului a fost
scoasd sau nu a fost

reinstalatd corect in sistem.

Reinstalati placa ridicatorului.

Ghid de depanare
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Mesaje de eroare ale testelor POST

Coduri numerice si mesaje text (Continuare)

Cod/Mesaij Cauza probabila Actiune recomandaté

1151-Serial Port A Ambele port-uri seriale, 1.

Address Conflict extern si intern, sunt

Detected (S-a detectat atribuite port-ului COM1. 9
un conflict la adresa

port-ului serial A)

Scoatefi toate placile de extensie
cu port serial.

. Goliti memoria CMOS. (Consultati

Anexa B, ,Securitatea prin parole
si reinitializarea memoriei CMOS*)

. Reconfigurafi resursele placii si/sau

executali programul Computer Setup sau
programele utilitare pentru Windows.

1152-Serial Port B Ambele port-uri seriale, 1.

Address Conflict extern si intern, sunt
Detected (S-a detectat atribuite port-ului COM?2.
un conflict la adresa

port-ului serial B)

N

Scoateti toate placile de extensie
cu port serial.

. Goliti memoria CMOS. (Consultati

Anexa B, ,Securitatea prin parole
si reinitializarea memoriei CMOS*)

. Reconfigurafi resursele placii si/sau

executali programul Computer Setup sau
programele utilitare pentru Windows.

1155-Serial Port Ambele port-uri seriale, 1.
Address Conflict extern si intern, sunt
Detected (S-a detectat atribuite aceleiasi cereri )

un conflict la adresa  de intrerupere (IRQ).
port-ului serial)

Scoatefi toate placile de extensie
cu port serial.

. Goliti memoria CMOS. (Consultati

Anexa B, ,Securitatea prin parole
si reinitializarea memoriei CMOS*)

. Reconfigurati resursele placii si/sau

executati programul Computer Setup sau
programele utilitare pentru Windows.

1201-System Audio  Adresa IRQ Intrafi in programul Computer Setup
Address Conflict a dispozitivului este in si resetati adresa IRQ din Advanced >
Detected (S-a detectat conflict cu alt dispozitiv. = Onboard Devices (Avansat - Dispozitive
un conflict la adresa montate pe placa de sistem).

sistemului audio)

1202-MIDI Port Adresa IRQ Intrafi in programul Computer Setup
Address Conflict a dispozitivului este in si resetati adresa IRQ din Advanced >
Detected (S-a detectat conflict cu alt dispozitiv. © Onboard Devices (Avansat — Dispozitive
un conflict la adresa montate pe placa de sistem).

port-ului MIDI)

A-10 www.hp.com
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Mesaje de eroare ale testelor POST

Coduri numerice si mesaje text (Continuare)

Cod/Mesaij Cauza probabila Actiune recomandaté
1203-Game Port Adresa IRQ Intrafi in programul Computer Setup
Address Conflict a dispozitivului este in si resetati adresa IRQ din Advanced >

Detected (S-a detectat
un conflict la adresa
port-ului pentru jocuri)

conflict cu alt dispozitiv. = Onboard Devices (Avansat — Dispozitive
montate pe placa de sistem).

1720-SMART Hard
Drive Detects
Imminent Failure
(Unitatea de disc
SMART detecteaza

o defecfiune iminenta)

Unitatea de disc este pe
cale s& se defecteze.
(Unele unitati de disc sunt
prevazute cu un patch
firmware care va remedia
un mesaj fals de eroare.)

. Determinati dacé unitatea de

disc trimite un mesaj de eroare corect.
Intrati in programul Computer Setup

si executati testul Drive Protection System
de sub Storage > DPS Self-test
(Stocare — Testare automat& DPS).

. Daca este cazul, utilizafi patch-ul

firmware pentru unitatea de disc.
(Disponibil la adresa
www.hp.com/support.)

. Faceti o copie de rezerva a confinutului

si inlocuiti unitatea de disc.

1785-Multibay
incorrectly installed
(Multibay

instalat incorect)

(pentru sisteme cu
componente opfionale

Multibay,/non-USDT)

1. Cablurile panglica
pentru Multibay nu
sunt pozifionate sau
nu sunt atasate corect.

2. Dispozitivul Multibay

nu este pozitionat 4

corect.

3. Este prezentd o unitate

de dischetd Multibay.

. Verificati dacé componenta opfionald

Multibay este atasata la cablul IDE
ca dispozitivul 0.

. Verificati dac& nu este atasat alt

dispozitiv la acelasi cablu IDE.

3. Verificati dacd ambele capete ale

cablurilor panglica IDE si Multibay sunt
pozifionate corect.

. Verificati daca dispozitivul Multibay

este introdus complet.

5. Verificafi dacd nu este prezenta

o unitate de dischetd Multibay (unitatile
de dischetd Multibay nu sunt acceptate
de componenta opfionala Multibay).

Ghid de depanare
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Mesaje de eroare ale testelor POST

Coduri numerice si mesaje text (Continuare)

Cod/Mesaij Cauza probabila Actiune recomandaté

1785-Multibay (pentru sisteme integrate 1. Verificati dac& dispozitivul Multibay
incorrectly installed  Multibay,/USDT) este introdus complet.

(MUlﬁbG_Y 1. Dispozitivul 2. Verificati daca ridicatorul Multibay este
mstalgt incorect) Multibay nu este pozifionat corect.

(continuare) pozitionat corect.

2. Ridicatorul
Multibay nu este
pozitionat corect.

1794-Inaccessible
devices attached
to SATA 1 and/or
SATA 3 (La SATA 1
si/sau SATA 3 sunt
atasate dispozitive
inaccesibile)

(pentru sisteme cu

4 port-uri SATA)

La SATA 1 si/sau SATA 3
este atasat un dispozitiv.
Dispozitivele atasate la
acesti conectori vor fi
inaccesibile cand in
programul Computer
Setup ,,SATA Emulation”
(Emulatie SATA) este setat
pe ,Combined IDE
Controller” (Controler IDE
combinat).

. Dacd utilizati Windows 2000

sau Windows XP, modificati setarea
+SATA Emulation” in , Separate IDE
Controller” (Controler IDE separat)
in programul Computer Setup.

. Dacé nu utilizati Windows 2000

sau Windows XP, mutati dispozitivele
afectate la SATA O sau SATA 2
(daca sunt disponibile).

. Scoateti dispozitivele afectate

de la SATA 1 si SATA 3.

1794-Inaccessible
device attached to
SATA 1 (Dispozitiv
inaccesibil atasat

la SATA 1)

(pentru sisteme cu
2 port-uri SATA)

La SATA T este atasat un
dispozitiv. Toate
dispozitivele atasate

la acesti conectori vor fi
inaccesibile cand in
programul Computer
Setup ,, SATA Emulation”
este setat pe ,Combined
IDE Controller”.

. Daca utilizati Windows 2000 sau

Windows XP, modificati , SATA
Emulation” in ,Separate IDE
Controller” (Controler IDE separat)

in programul Computer Setup.

. Daca nu utilizati Windows 2000

sau Windows XP, mutati dispozitivele

afectate la SATA O (daca este disponibil).

. Scoateti dispozitivul afectat

de la SATA 1.

1796-SATA Cabling

Unul sau mai multe

Verificati dacd conectorii SATA sunt

dispozitive SATA sunt
atasate incorect. Pentru
performante optime,
conectorii SATA O si SATA
1 trebuie utilizati inainte
de cei SATA 2 si SATA 3.

utilizati in ordine crescatoare. Pentru un
dispozitiv, utilizafi SATA O. Pentru doud
dispozitive, utilizati SATA O si SATA 1.
Pentru trei dispozitive, utilizati SATA O,
SATA1 si SATA 2.

Error (Eroare la cablul

pentru SATA)

Ghid de depanare
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Mesaje de eroare ale testelor POST

Coduri numerice si mesaje text (Continuare)

Cod/Mesaij Cauza probabila Actiune recomandaté
1800-Temperature Temperatura internd 1. Verificati daca orificiile de ventilatie
Alert (Alarma depaseste specificatia. ale computerului nu sunt blocate

de temperatura) si daca ventilatorul de racire

a procesorului functioneaza.

Verificati selectia vitezei procesorului.

Inlocuiti placa de sistem.

2.
3. Inlocuiti procesorul.
4.
1.

1801-Microcode Procesorul nu este Facefi upgrade de BIOS,

Patch Error (Eroare acceptat de memoria la versiunea corectd.

de patch Microcode) ROM BIOS. 2. Schimbafi procesorul.

1998-Master Boot Copia inregistrarii MBR  Executati programul Computer Setup
Record has been salvaté anterior si salvati inregistrarea MBR a discului
Lost (S-a pierdut a fost corupta. curent de incdrcare a sistemului.
inregistrarea principald

de incdrcat)

1999-Master Boot Inregistrarea curents MBR  Acordati atentie maxima. Inregistrarea
Record has Changed  nu corespunde cu copia  MBR este posibil sa fi fost actualizata

(S-a modificat inregistrarii MBR datorit& activitatilor normale de intretinere
inregistrarea salvatd anterior. a discului (DISK MANAGER, FDISK
principald de incarcat) sau FORMAT).

Prin tnlocuirea in asemenea situatii

a inregistrarii MBR salvate anterior,

pot rezulta pierderi de date.
Daca sunteti sigur ca modificarea
nregistrarii MBR este neintenfionatd
si nedoritd (de ex. datorit& unui virus),
executali programul Computer Setup
si restaurati copia inregistrarii MBR salvata
anterior. In caz contrar, executati programul
Computer Setup si dezactivati securitatea
inregistrarii MBR sau salvati inregistrarea
MBR a discului curent de incarcare
a sistemului.
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Mesaje de eroare ale testelor POST

Coduri numerice si mesaje text (Continuare)

Cod/Mesaij Cauza probabila Actiune recomandaté
2000-Master Boot Unitatea curentd de disc ~ Executati programul Computer Setup
Record Hard Drive has  pentru incarcarea si dezactivali securitatea inregistrarii MBR

Changed (A fost
schimbat& unitatea de
disc cu inregistrarea
principala de incarcat)

sistemului nu este
aceeasi cu cea prezentd
la activarea securitdtii
inregistrarii MBR.

sau salvati inregistrarea MBR a discului
curent de incarcare a sistemului.

Invalid Electronic
Serial Number
(Numar electronic
de serie nevalid)

Numarul electronic
de serie a fost corupt.

. Executati programul Computer Setup.

Daca programul Setup are deja date
in acest cdmp sau dacd nu permite
introducerea numdarului de serie,
descarcati de la adresa www.hp.com
si executali programul

SP5572.EXE (SNZERO.EXE).

. Executati programul Computer Setup

si incercati sd introduceti numarul
de serie sub Security, System ID, apoi
salvati modificarile.

Network Server Mode
Active and No
Keyboard Attached
(Modul de server

de refea este activ

si nu existd

tastaturd atasata)

Defectiune la tastaturd
céind este activat modul
de server de refea.

2.

3.

4.

. Reconectati tastatura cénd computerul

este oprit.

Verificati daca la conector exista pini
indoiti sau daca lipsesc pini.
Verificali dacd nu este apasatd nici
o tasta.

Inlocuiti tastatura.

Parity Check 2

(Verificare paritate 2)

Defectfiune de paritate
a memoriei RAM.

Executati programul Computer Setup
si programele utilitare de diagnosticare.

System will not boot
without fan (Sistemul
nu se incarca fara
ventilator)

Ventilatorul de CPU nu
este instalat sau este

deconectat de la sasiul
VSFF.

1.

Deschideti capacul, apasati butonul de
alimentare si verificati dacéd ventilatorul
procesorului se roteste. Daca
ventilatorul procesorului nu se roteste,
verificati modul de conectare

a cablului ventilatorului la placa de
sistem. Verificati dac& ventilatorul este
pozifionat si instalat corect.

. Daca ventilatorul este conectat

si pozifionat corect, dar nu se roteste,
inlocuiti-l.

www.hp.com
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Mesaje de eroare ale testelor POST

LED-vurile de diagnosticare de pe panoul frontal
si codurile sonore pentru testele POST

Aceastd sectiune trateazd codurile LED-urilor de pe panoul frontal si
codurile sonore care pot surveni Tnaintea sau in timpul testelor POST,
cdrora nu le este asociat neapdrat un cod de eroare sau un mesaj text.

% Dacd pe o tastaturd PS/2 observati LED-uri care clipesc, cdutati
LED-urile care clipesc pe panoul frontal al computerului si consultati
tabelul de mai jos pentru a determina codul asociat acestora.

% Actiunile recomandate din tabelul de mai jos sunt listate in ordinea
in care trebuie efectuate.

LED-urile de diagnosticare de pe panoul frontal
si codurile sonore

Semnale
Activitate sonore Cauzéa posibila Actiune recomandaté
LED-ul de Fara Computer pornit.  Fara
alimentare este
aprins verde.
LED-ul verde de Fara Computerul este Nu este necesard nici o acfiune.
alimentare clipeste n modul de Apasati pe orice tasta sau miscati mausul
din doud in dous suspendare in pentru a porni computerul.
secunde. memoria RAM

(numai la anumite
modele) sau in
modul normal

de suspendare.
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Mesaje de eroare ale testelor POST

LED-urile de diagnosticare de pe panoul frontal
si codurile sonore (Continuare)

Semnale
Activitate sonore

Cauza posibila Actiune recomandata

LED-ul rosu de 2
alimentare clipeste

de doud ori, o datd

pe secundd, dupd

Protectia termicd 1.

a procesorului
este activata:

Un ventilator este

Verificati dacé orificiile de ventilatie
ale computerului nu sunt blocate

si dacd ventilatorul de récire

a procesorului funcfioneaza.

care urmeaza blocat sau nu 2. Deschideti capacul, apasati butonul

o pauzd de doud se roteste. de alimentare si verificati dacé

secunde. SAU ventilatorul procesorului se roteste.
Ansamblul Daca ventilatorul procesorului nu se
radiator/ventilator roteste, ve'rificc.ﬁ modul' de conectare
nu esfe atasat a cablului Y'enhl'oforulw la !oloco de
corect la procesor. sistem. Verificati dacé ventilatorul

este pozitionat si instalat corect.

3. Daca ventilatorul este conectat
si pozifionat corect, dar nu
se roteste, inlocuifil.

4. Repozifionati radiatorul procesorului
si verificati dacd ansamblul
ventilatorului este atasat corect.

5. Contactati un distribuitor sau furnizor
de servicii autorizat.

LED-ul rosu de 3 Procesorul nu este 1. Verificati dacd procesorul

alimentare clipeste
de trei ori, o datd

pe secundd, dupa
care urmeazd

o pauzda de doud

secunde.

instalat (nu este
un indicator de
procesor defect).

este prezent.

2. Repozitionati procesorul.

www.hp.com
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Mesaje de eroare ale testelor POST

LED-urile de diagnosticare de pe panoul frontal
si codurile sonore (Continuare)

Activitate

Semnale
sonore

Cauza posibila Actiune recomandata

LED-ul rosu de
alimentare clipeste
de patru ori, o datd
pe secundd, dupd
care urmeazd

o pauzd de doud
secunde.

4

Eroare de
alimentare (sursa
de alimentare este
suprasolicitatd).

1. Deschidefi capacul si verificati
pozifionarea cablului de alimentare
cu 4 fire in conectorul de pe placa
de sistem.

2. Verificati dacd problema este
generatda de un dispozitiv; scoatefi
TOATE dispozitivele atasate (precum
unitdtile de disc, de discheta sau
optice si placile de extensie). Pornii
sistemul. Daca sistemul intrd in testarile
POST, opriti- si repetai aceastd
procedurd monténd la loc, pe rénd,
céte un dispozitiv, pana cand apare
defectiunea. Inlocuiti dispozitivul care
a provocat defectiunea. Continuati
s& adaugati cate un dispozitiv, pentru
a verifica dacd toate dispozitivele
functioneazé corect.

3. Inlocuiti sursa de alimentare.

4. Inlocuiti placa de sistem.

LED-ul rosu de
alimentare clipeste
de cinci ori, o dat&
pe secundd, dupd
care urmeazd

o pauzd de doud
secunde.

Eroare inaintea
memoriei video.

1. Repozitionafi modulele DIMM.
Porniti sistemul.

2. Pentru a identifica modulul defect,
inlocuiti pe rénd modulele DIMM.

3. Inlocuiti memoria de la ali furnizori
cu memorie de la HP.

4. Inlocuiti placa de sistem.

Ghid de depanare
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Mesaje de eroare ale testelor POST

LED-urile de diagnosticare de pe panoul frontal
si codurile sonore (Continuare)

Semnale
Activitate sonore Cauzéa posibila Actiune recomandaté
LED-ul rosu de 6 Eroare inainte de  Pentru sistemele cu o placa grafica:
alimentare clipeste placa grafica 1. Repozifionati placa grafica.
de sase ori, o dat& video. Porniti sistemul.
pe secundg, fiupé 2. Inlocuiti placa grafica.
care urmeaz& 2 o .
% de doud 3. Inlocuiti placa de sistem.
o pauzé de _ N o
secunde. Pentru sistemele cu placa grafica
integratd, inlocuiti placa de sistem.
LED-ul rosu de 7 Defectiune la Inlocuiti placa de sistem.
alimentare clipeste placa de sistem
de sapte ori, o datd (memoria ROM
pe secundd, dupd a detectat
care urmeazé o defectiune
o pauzd de doud inainte de placa
secunde. video).
LED-ul rosu de 8 Memorie ROM 1. Curétati din nou memoria ROM,
alimentare clipeste nevalidg, pe baza utilizand o dischetds ROMPaq.
de opt ori, o dat& unei sume de Consultati sectiunea ,, Curdtarea
pe secundd, dupd control (checksum) memoriei ROM” din Ghid de
care urmeazd gresite. gestionare a computerului de pe
o pauzd de doud Documentation CD.
secunde. 2. Inlocvuiti placa de sistem.
LED-ul rosu de 9 Sistemul porneste 1. Verificati dacd selectorul de

alimentare clipeste
de noud ori, o dat&
pe secundd, dupa
care urmeazad

o pauzda de doud
secunde.

dar nu se incarca.

tensiune, amplasat in partea din
spate a sursei de alimentare

(la anumite modele), este setat la
tensiunea corespunzdatoare. Setarea
corectd a fensiunii depinde de
regiunea in care va aflati.

2. Tnlocuiti placa de sistem.

3. Inlocuiti procesorul.

www.hp.com

Ghid de depanare



Mesaje de eroare ale testelor POST

LED-urile de diagnosticare de pe panoul frontal
si codurile sonore (Continuare)

Semnale
Activitate sonore Cauzéa posibila Actiune recomandaté
LED-ul rosu de 10 Placa optionals 1. Verificati fiecare placa grafica prin
alimentare clipeste defecta. scoaterea placilor pe rand (daca
de trei ori, o datd existd mai multe placi), apoi pornii
pe secundd, dupd sistemul pentru a vedea dacs
care urmeazd dispare defectiunea.
o pauzé de doud 2. Dacé afi identificat o placa defectd,

secunde. scoateti-o si inlocuifi-o.

3. Inlocuiti placa de sistem.
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Mesaje de eroare ale testelor POST

LED-urile de diagnosticare de pe panoul frontal

si codurile sonore (Continuare)

Semnale
Activitate sonore

Cauzd posibila

Actiune recomandaté

Sistemul nu Fara
porneste si LED-urile
nu clipesc.

Sistemul nu se
poate alimenta.

Tineti apasat butonul de alimentare mai
putin de patru secunde. Daca LED-ul
unitatii de disc se aprinde verde:

1.

Verificati dacé selectorul de tensiune,
amplasat in partea din spate a sursei
de alimentare este setat la tensiunea
corespunzdtoare. Setarea corectd

a tensiunii depinde de regiunea

in care va aflati.

. Scoateti pe rand toate placile de

extensie, pana cand se aprinde
indicatorul luminos 3V_aux de pe
placa de sistem.

3. Inlocuiti placa de sistem.
SAU
Tineti apasat butonul de alimentare mai

putin de patru secunde. Daca LED-ul
unitdtii de disc nu se aprinde verde:

1.

Verificati dac& unitatea este conectatd
la o priza de c.a. funcfionals.

. Deschidefi capacul si verificati daca

firele butonului de alimentare sunt
conectate corect la placa de sistem.

. Verificati dacd ambele cabluri ale

sursei de alimentare sunt conectate
corect la placa de sistem.

. Verificati dacé indicatorul luminos

3V_aux de pe placa de sistem este
aprins. Dacd este aprins, inlocuifi
firele butonului de alimentare.

. Dacé indicatorul luminos 3V_aux de

pe placa de sistem nu este aprins,
inlocuiti sursa de alimentare.

6. Tnlocuiti placa de sistem.

A-20
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Securitatea prin parole si reinitializarea

memoriei CMOS

Acest computer accepta caracteristici de securitate prin parole, care
se pot stabili prin meniurile programelor utilitare Computer Setup.

Acest computer acceptd doud caracteristici de securitate prin parole,
care se pot stabili prin meniurile programelor utilitare Computer
Setup: parola de setare si parold de pornire. Cand stabiliti doar

o parola de setare, oricare utilizator poate sa acceseze toate
informatiile de pe computer, cu exceptia programului Computer
Setup. Cand stabiliti doar o parola de pornire. aceasta este obligatorie
pentru a accesa programul Computer Setup si orice altd informatie
de pe computer. Cand stabiliti ambele parole, numai parola de setare
vd va permite accesul la programul Computer Setup.

Cand s-au setat ambele parole, parola de setare se mai poate utiliza
si in locul parolei de pornire pentru conectarea la computer. Pentru
un administrator de retea, aceasta este o caracteristica utila.

Dacd uitati parola pentru computer, existd doud metode de stergere
a parolei, astfel incat sd aveti posibilitatea sa obtineti accesul
la informatiile de pe computer:

B Resetarea jumperului pentru parola

B Utilizarea butonului de golire a memoriei CMOS

ATENTIE: Prin apdsarea butonului CMOS se vor reiniializa valorile CMOS
la cele implicite, din fabricg, si se vor sterge toate informatiile particularizate,
inclusiv parolele, numerele de inventar si setarile implicite. Este important

ca inainte de resetare sd faceti o copie de rezervéa a setarilor CMOS ale
computerului pentru cazul in care setérile vor fi necesare ulterior. Copierea de
rezerva se face cu usurini& prin programul Computer Setup. Pentru informatii
despre efectuarea unei copii de rezerva a setarilor CMOS, consultati Ghidul
programului utilitar Computer Setup (F10) de pe Documentation CD.

Ghid de depanare
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Securitatea prin parole si reinifializarea memoriei CMOS

Resetarea jumperului pentru parold

Pentru a dezactiva caracteristicile de parold de pornire sau de
parold de setare, sau pentru a sterge aceste parole, completati pasii
de mai jos:

1. Opriti corect sistemul de operare, apoi opriti computerul si toate
dispozitivele externe si deconectati de la prizd cablul de alimentare.

2. Cu cablul de alimentare deconectat, apdsati din nou butonul
de alimentare pentru a goli sistemul de orice energie reziduald.

é AVERTISMENT: Pentru a reduce riscul de ré&nire din cauza socurilor
electrice si/sau a suprafetelor fierbinti, decuplati cordonul de alimentare
de la priza si asteptati pand cénd componentele interne ale sistemului se
r&cesc, inainte de a le atinge.

ff ATENTIE: Cand computerul este conectat, sursa de alimentare furnizeaza
tensiune la placa de sistem, chiar dac& unitatea este opritd. Dacd nu se
deconecteazd cablul de alimentare poate rezulta deteriorarea sistemului.

ff ATENTIE: Electricitatea staticd poate s& deterioreze componentele electronice
ale computerului sau echipamentele opfionale. inainte de a incepe aceste
proceduri, aveli grijd sa va descdrcati de electricitatea statica atingand un
obiect metalic legat la pamant. Pentru mai multe informatii, consultati Informatii
despre norme si despre sigurantd de pe Documentation CD.

3. Scoateti capacul sau panoul de acces la computer.

4. Gasiti mufa si jumperul.

% Jumperul pentru parola are culoarea verde, astfel Tncat se poate
identifica usor. Pentru asistenta privind gasirea jumperului pentru
parold, vezi Illustrated Parts Map (Schita componentelor ilustrate)
(IPM) pentru sistemul in cauza. IPM se poate descérca de la adresa
www.hp.com/support.

5. Scoateti jumperul de la pinii 1 si 2. Puneti jumperul pe pinul
1 sau pe pinul 2, dar nu pe amandoi, astfel incat sd nu se piarda.

6. Puneti la loc capacul sau panoul de acces la computer.

7. Reconectati echipamentul extern.
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8. Conectati computerul la prizd si porniti-1. Asteptati sd porneasca
sistemul de operare. Prin aceasta se sterge parola curenta si se
dezactiveaza caracteristicile de parola.

9. Pentru a stabili alte parole, repetati pasii de la 1 la 4, puneti la loc
jumperul pentru parola pe pinii 1 si 2, apoi repetati pasii de la 6 1a 8.
Stabiliti noile parole din programul Computer Setup. Pentru
instructiuni despre setarea computerului, consultati Ghidul
programului utilitar Computer Setup (F10) de pe
Documentation CD.

Stergerea si resetarea memoriei CMOS

Memoria de configuratie a computerului (CMOS) péstreaza
informatiile despre parola si informatii despre configuratia
computerului.

Utilizarea butonului CMOS

/\
JAN

1. Opriti computerul si toate dispozitivele externe si deconectati
de la priza cablul de alimentare.

2. Deconectati tastatura, monitorul si orice alte echipamente externe
conectate la computer.

AVERTISMENT: Pentru a reduce riscul de ré&nire din cauza socurilor electrice
si/sau a suprafefelor fierbinti, decuplati cordonul de alimentare de la priza
si asteptali pand cand componentele interne ale sistemului se racesc, inainte
de a le atinge.

ATENTIE: Cand computerul este conectat, sursa de alimentare furnizeaza
tensiune la placa de sistem, chiar daca unitatea este oprita. Dacd nu se
deconecteazd cablul de alimentare poate rezulta deteriorarea sistemului.

ATENTIE: Electricitatea staticd poate sa deferioreze componentele electronice
ale computerului sau echipamentele optionale. Inainte de a incepe aceste
proceduri, aveli grijd s& va descdrcati de electricitatea statica atingand un
obiect metalic legat la pamant. Pentru mai multe informatii, consultati Informatii
despre norme si despre sigurantd de pe Documentation CD.
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Securitatea prin parole si reinifializarea memoriei CMOS

3. Scoateti capacul sau panoul de acces la computer.

ATENTIE: Prin apasarea butonului CMOS se vor reseta valorile CMOS la cele
implicite, din fabricd, si se vor sterge toate informatiile particularizate, inclusiv
parolele, numerele activelor si setarile implicite. Este important ca inainte de
resetare s& faceti o copie de rezervd a setdrilor CMOS ale computerului pentru
cazul in care setdrile vor fi necesare ulterior. Copierea de rezerva se face cu
usurinja prin programul Computer Setup. Pentru informatii despre efectuarea
unei copii de rezerva a sefarilor CMOS, consultati Ghidul programului utilitar
Computer Setup (F10) de pe Documentation CD.

4. Gasiti si tineti apasat butonul CMOS timp de cinci secunde.

% Verificati daci ati deconectat de la prizd cablul de alimentare c.a.
Butonul CMOS nu va sterge memoria CMOS 1in cazul 1n care cablul
de alimentare este conectat.

Butonul CMOS

%\ Pentru asistentd privind gisirea butonului CMOS, vezi Illustrated
Parts Map (IPM) pentru sistemul in cauza.

5. Puneti la loc capacul sau panoul de acces la computer.
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ES

6. Reconectati dispozitivele externe.
7. Conectati computerul la prizd si porniti-1.

Dupad stergerea memoriei CMOS si resetare, veti primi mesaje de
eroare ale testelor POST prin care sunteti anuntat ca au survenit
modificdri ale configuratiei. Utilizati programul Computer Setup
pentru a restabili parolele si toate setdrile speciale de sistem Tmpreund
cu data si ora.

Pentru mai multe instructiuni despre restabilirea parolelor, consultati
Ghid de gestionare a computerului de pe Documentation CD. Pentru
mai instructiuni privind setarea computerului, consultati Ghidul
programului utilitar Computer Setup (F10) de pe Documentation CD.

Utilizarea programului Computer Setup pentru a reseta
memoria CMOS

Pentru a reseta memoria CMOS prin intermediul programului
Computer Setup, trebuie mai intai sd accesati meniul programelor
utilitare Computer Setup.

Cand apare mesajul Computer Setup in coltul din dreapta jos al
ecranului, apdsati tasta F10. Daci este necesar, apdsati tasta Enter
pentru a trece de ecranul de titlu.

Daci nu apasati tasta F10 in timpul in care este afisat mesajul, trebuie sa
opriti computerul, apoi sd-1 reporniti pentru a accesa programul utilitar.

In meniul programelor utilitare Computer Setup apar cinci titluri

de selectat: File, Storage, Security, Power, si Advanced (Fisier,
Stocare, Securitate, Putere si Avansat).

Pentru a reseta memoria CMOS la setarile prestabilite din fabrica,
mai Intai setati ora si data, apoi utilizati tastele sigeti sau tasta Tab
pentru a selecta File > Set Defaults and Exit (Fisier — Setare valori
prestabilite si iesire). Prin acesta se reseteaza setérile soft care includ
ordinea secventei de incircare si alte setdri de fabricd. Totusi, nu va
proceda la reidentificarea dispozitivelor hardware.

Pentru mai multe instructiuni despre restabilirea parolelor, consultati
Ghid de gestionare a computerului de pe Documentation CD. Pentru
mai instructiuni privind setarea computerului, consultati Ghidul
programului utilitar Computer Setup (F10) de pe Documentation CD.
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Drive Protection System (DPS)

Sistemul de protectie a unitdtilor (DPS) este un instrument de
diagnosticare Tncorporat in unitatile de disc instalate la anumite
computere. Sistemul DPS a fost conceput pentru a ajuta la
diagnosticarea problemelor care pot avea ca rezultat inlocuirea
nejustificatd a unititilor de disc.

Cand sunt construite aceste sisteme, fiecare unitate de disc instalati
este testatd utilizand sistemul DPS, iar pe unitate se scrie

o inregistrare permanentd cu informatii esentiale. Rezultatele testirii
sunt scrise pe unitatea de disc de fiecare datd cand se executa sistemul
DPS. Furnizorul de servicii poate sd utilizeze aceste informatii pentru
a determina conditiile care au impus executarea software-ului DPS.

Prin executarea programului DPS nu se vor afecta programele sau datele
stocate pe unitatea de disc. Testul este rezident Tn firmware-ul unitétii de
disc si se poate executa chiar in cazul in care computerul nu va incédrca
un sistem de operare. Timpul necesar pentru executarea testului depinde
de producitor si de dimensiunea unitétii de disc; in majoritatea cazurilor
testul va dura aproximativ doud minute/gigaoctet.

Utilizati programul DPS céand suspectati o problema la unitatea de disc.
In cazul in care computerul raporteazi un mesaj SMART Hard Drive
Detect Imminent Failure (Unitatea de disc SMART detecteazi

o defectiune iminentd), nu este necesar sd executati programul DPS;

in schimb, faceti o copie de rezervd a informatiilor de pe unitatea de disc
si contactati un furnizor de servicii pentru inlocuirea unititii de disc.
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Drive Protection System (DPS)

Accesarea DPS prin programul Diagnostics

for Windows

Pentru a accesa DPS prin programul Diagnostics for Windows,
efectuati pasii de mai jos:

1.

Porniti computerul si selectati Start > Control Panel >
Diagnostics for Windows.

Pe ecranul Diagnostics apar cinci titluri de selectat: Overview,
Test, Status, Log, si Error (Prezentare generald, Stare, Jurnal
si Eroare).

. Selectati Test > Type of Test (Test — Tipul testului).

Aveti posibilitatea sd alegeti unul dintre urmétoarele trei teste:
Quick Test, Complete Test si Custom Test (Test rapid, Test
complet si Test particularizat).

. Selectati Custom Test.

Vi se oferd posibilitatea sd alegeti dintre doud moduri de testare:
Interactive Mode si Unattended Mode (Mod interactiv si Mod
nesupravegheat).

. Selectati Interactive Test > Storage > Hard Drives

(Test interactiv — Stocare — Unititi de disc).

. Selectati care anume dintre unitdti sd fie testatd > Drive

Protection System Test > Begin Testing (Testare a sistemului
de protectie a unititilor — Incepere testare).

Dupa finalizarea testului, pentru fiecare dintre unitdtile testate
se va afisa unul dintre urmatoarele trei mesaje:

Test Succeeded. Completion Code 0. (Testare reusitd. Cod la
finalizare 0.)

Test Aborted. Completion Code X. (Testare abandonatd. Cod la
finalizare X, unde X = 1 sau 2)

Test Failed. Drive Replacement Recommended. Completion
Code X. (Testare nereusitd. Se recomandd inlocuirea unitétii.
Cod la finalizare X, unde X =3 ... 14)

Daci testul nu a reusit, codul de la finalizare trebuie inregistrat si raportat
furnizorului de servicii pentru a fi de ajutor la diagnosticarea problemei
computerului.
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Accesarea DPS prin intermediul programului
Computer Setup

Cénd computerul nu porneste corect, trebuie sd utilizati programul
Computer Setup pentru a accesa programul DPS. Pentru a accesa
programul DPS, efectuati pasii urmétori

1. Porniti sau reporniti computerul.

2. Cand apare mesajul F10 Setup in coltul din dreapta jos al
ecranului, apasati tasta F10.

Daca nu apasati tasta F10 in timpul in care este afisat mesajul, trebuie sa
opriti computerul, apoi sa-1 reporniti pentru a accesa programul utilitar.

In meniul programelor utilitare Computer Setup apar cinci titluri
de selectat: File, Storage, Security, Power, and Advanced.

3. Selectati Storage > DPS Self-Test (Stocare — Testare
automata DPS).

Pe ecran se va afisa lista unitatilor de disc cu capacitate DPS care
sunt instalate pe computer.

Daca nu este instalatd nici o unitate de disc cu capacitate DPS,
optiunea DPS Self-Test nu va aparea pe ecran.

4. Selectati unitatea de disc pentru testare si urmati solicitdrile
de pe ecran pentru a finaliza procesul de testare.

Dupa finalizarea testului se va afisa unul dintre urméatoarele
trei mesaje:

B Test Succeeded. Completion Code 0. (Testare reusitd.
Cod la finalizare 0.)

B Test Aborted. Completion Code X. (Testare abandonata.
Cod la finalizare X, unde X = 1 sau 2)

B Test Failed. Drive Replacement Recommended. Completion
Code X. (Testare nereusitd. Se recomanda inlocuirea unitatii.
Cod la finalizare X, unde X =3 ... 14)

Daca testul nu a reusit, codul de la finalizare trebuie inregistrat
si raportat furnizorului de servicii pentru a fi de ajutor la diagnosticarea
problemei computerului.
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Configurarea iesirilor audio
analogice/digitale

Unele computere pot fi dotate cu o solutie audio integrata care acceptd
difuzoare stereo externe, analogice sau digitale. Aceste sisteme sunt
capabile sd sesizeze automat tipul de difuzor si s emitd semnalul
corect. Pentru a comuta manual Intre analog, digital si auto-sense
(sesizare automatd), urmati intreaga procedurd de mai jos, in functie
de sistemul de operare.

% Dacéd Output Mode (Mod de iesire) este setat ca digital, difuzorul
intern si difuzoarele externe analogice nu vor emite semnale audio
pana cand nu comutati la loc pe unul din modurile auto-sense sau
analog. Dacd Output Mode este setat ca analog, difuzoarele digitale
externe nu vor functiona pand cand nu modificati modul de iesire la
loc, pe unul din modurile auto-sense sau digital.

In Microsoft Windows XP:
1. Faceti clic pe Start > Control Panel, apoi faceti dublu clic
pe pictograma Sounds, Speech, and Audio Devices (Sunete,
vorbire si dispozitive audio).
2. Selectati fila Hardware.
. Evidentiati dispozitivul audio corespunzitor.
4. Faceti clic pe Properties (Proprietiti) pentru as deschide panoul
Device Properties (Proprietiti dispozitiv).
5. Faceti clic pe fila Properties.

. Faceti clic pe semnul ,,+* de 1anga Audio Devices pentru
a se extinde.

. Evidentiati driverul corespunzétor, ficand clic pe acesta.

. Faceti clic pe Properties (Proprietiti).

. Faceti clic pe Settings (Setdri).

10. Modificati Output Mode (Mod de iesire) cu setarea dorita.
11. Faceti clic pe OK pentru a inchide panoul Properties.

12. Inchideti Control Panel.

(98]
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